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About 
This application is a powerful yet easy-to-use reporting tool. It runs in your web browser and does not require any downloads.
Supported Browsers

Supported browsers include:

· Firefox 3+
· Internet Explorer 8+
· Google Chrome

· Safari

Navigation
This application consists of two sections. On the left is the Main Menu and on the right are Tabs. The Main Menu displays the available reports, folders and buttons. Tabs can contain the New Report Wizard, report outputs, design windows, or help pages.
[image: image2.png]Tabs

+0 Categories v

= 3 @ CategorylD
“ a o CategoryName
. Description
Xje Picture

» £ Customer Reports

» £ Order Details 2015

1 Sales Reports
Weekly Sales

» £ Seasonal Reports

* Add

BE

P
Secton

Page Header

Detai

Report Footer

B / aia

EZUAD: B

| [ Weekly Sales * [ Orders 2014 [ Dashboard a

. s e
== o
A(ProductiD) | B (Productilame) |C (QuaniiyPerUnt)| D (UniPrie)
Weekly Sales
Productld _ ProductName _QuantityPerUnit  UnitPrice
eroducts Procuctp F1odUcts Producta’Products QuanityP "ot uniprce
Products
0
=
g
£
5 sis
s
»
1 2 3 4
J—





Main Menu
Through the Main Menu you can:

· Create new reports.
· Search for reports.
· Read report descriptions.
· Execute reports as HTML, Excel, CSV, RTF and PDF.
· Duplicate reports to save time setting up reports that are similar.
· Edit reports.
· Delete reports that are not needed.
· Schedule reports to be emailed.
· Manage folders and report storage.
Click the arrows ([image: image3.png]


) to hide the Main Menu. These arrows are located between the Main Menu and the Tabs.
Tabs
The right section is made up of tabs containing the New Report Wizard, reports outputs, design windows, or help pages. Tabs can be closed by clicking the ‘x’ to the right of the tab name. See below.
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Tabs can be rearranged by clicking and dragging them left or right. See below.
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Types of Reports

This application has five types of reports.

· [image: image6.png]


 Express Reports – This simplified report designer enables you to quickly build reports with basic layouts and calculations. For more information see Express Reports.
· [image: image7.png]


 Standard Reports – This type of report uses an intuitive grid to layout data and labels. Standard reports can provide more complex sections to group data and make specialized calculations. For more information see Report Designer.
· [image: image8.png]


 CrossTab Reports – CrossTab reports utilize the Standard Report Designer to create reports that may expand both horizontally and vertically based on data. For more information see CrossTabs.
· [image: image9.png]


 Dashboards – A canvas to combine and lay out reports, data visualizations, images, text and web pages. For more information see Dashboards.
· [image: image10.png]


 Chained Reports – This type of report compiles multiple reports into a single document. For more information see Chained Reports.
Creating New Reports
To create a new report, click the New Report Button. This will launch the New Report Wizard in a new tab.
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The New Report Wizard has five sub tabs. Only the Name and Categories tabs are required. 
1. Name: Give the report a title, specify a folder for the report and add an optional description to display in the Main Menu.
2. Categories: Select the Data Categories you want to access on the report.
3. Sorts: (optional) Select the Data Fields you want to sort by.
4. Filters: (optional) Select the Data Fields you want to filter by.
5. Layout: (optional) Select the Data Fields you want to appear on the report.
NOTE. Depending on the permissions you’ve been given the New Report Button may open a dropdown menu to create different types of reports.
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· Click the New Express Report Button ([image: image13.png]


) to create an Express Report. See Express Reports.

· Click the New Standard Report button ([image: image14.png]


) to create a regular report. See New Standard Report Wizard.
· Click the New CrossTab Report button ([image: image15.png]


) to create a CrossTab report. See New CrossTab Wizard.
· Click the New Dashboard button ([image: image16.png]


) to create a Dashboard. See Creating and Editing Dashboards.

· Click the New Chained Report button ([image: image17.png]


) to create a Chained Report. See Chained Reports.

New Standard Report Wizard

The New Standard Report Wizard is an interactive tool which will walk through the process of creating a new standard report. All of the selections made in the New Standard Report Wizard can be modified in the Report Designer after the report is created.
To navigate the wizard either click the desired tab or use the buttons at the bottom.
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The New Report Wizard has five sub tabs. The Name and Categories tabs must be completed while the other tabs are optional.
Name Tab
In the Name tab enter a report name and click on the Folder where the report will be saved.
The report name can be up to 255 characters. Avoid special characters such as ? : / \ * “ < >.
The report’s description appears at the bottom of the Main Menu when it is selected. The description text is also used when searching for a report.
NOTE. You cannot create a report inside a folder that is read-only ([image: image19.png]


).
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Complete the steps in the wizard below to create a new report
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Categories Tab

In the Categories tab select the Data Categories that you would like to have access to on the report. It is important to understand two terms: Data Category and Data Field.
Data Category – A Data Category is a data object that has several attributes. Ex. Students is a category; each student has an ID, a major, an advisor etc.
Data Field – A Data Field is a single attribute within a category. Ex. Students.ID is the numeric value that identifies a specific student.
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· To add a Data Category either drag and drop it to the ‘Category Name’ Column, use the ‘Add’ button or double-click it.
· To search for a specific Data Category or folder, type its name into the Search box.

· To see what Data Fields are in a Data Category click the information button ([image: image22.png]


).
· Check the ‘Suppress Duplicates’ box to prevent duplicate information from appearing on the report.

· To remove a Data Category click the delete button ([image: image23.png]


).
Sorts Tab

In the Sorts tab specify which Data Fields will be used to determine the order of data on the report.
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· To sort by a Data Field either drag and drop it to the ‘Sort By’ Column, use the ‘Add’ button or double-click it.
· You can sort each Data Field in ascending (A- Z) or descending (Z-A) order.
· Use the up and down arrows to indicate the sort priority.
· To remove a sort click the delete button ([image: image25.png]


).

Filters Tab

In the Filters Tab create statements that will be used to filter the data when you execute the report.
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There is no limit to the number of filters that can be defined. Filters can be numeric (up to eight decimal places) or alphanumeric.
· To filter a Data Field either drag and drop it to the ‘Filter By’ column, use the ‘Add’ button or double-click it.
· Use the up and down arrows to indicate the filter priority.
· To remove a filter click the delete button ([image: image27.png]


).
· Set the operator (equal to, less than, one of, etc.) by selecting it from the operator drop-down.
· Set the filter value by either entering it manually or selecting a value from the drop-down. If the Data Field is a date the calendar and function buttons can be used to select a value.
· Select ‘AND With Next Filter’ to require that the selected filter and the one below it are both true. Choose ‘OR With Next Filter’ to require that either be true.
· Check ‘Group With Next Filter’ to specify the precedence of the filters. Filters can be nested indefinitely by using the following keyboard shortcuts while a filter is selected: 
· Ctrl + [ adds an open-parenthesis before the selected filter.
· Ctrl + ] adds a close-parenthesis after the selected filter.
· Ctrl + Shift + [ removes an open-parenthesis from before the selected filter.
· Ctrl + Shift + ] removes a close-parenthesis from after the selected filter. 
· Check ‘Prompt for Value’ to allow the filter to be modified at the time the report is executed.

Layout Tab

In the Layout tab select the Data Fields that will appear on the report. For each Data Field chosen, the report will automatically create a column header and place the Data Field in the detail section. Additionally, sub-totals, grand totals, and a page header/footer can be created.
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Display Data

· To place a Data Field on the report either drag and drop it to the ‘Data Field’ column, use the ‘Add’ button or double-click it.
· Use the up and down arrows to indicate the order the Data Fields should appear on the report. The Data Field at the top will appear on the report as the left most column.
· The Summary Function column is used to make sub-totals and grand totals. See Sub-Totals and Grand Totals for more information.

· To remove a Data Field click the delete button ([image: image29.png]


).

Using the ‘Summarize By’ box you can display sub-totals, grand totals or headers for each unique value of a Data Field.
Sub-Totals and Grand Totals

· To display sub-totals, check the box of the category you want sub-totals for in the Summarize By box. Then for each Data Field you want totaled select a Summary Function (see below).
· To display grand totals check the Grand Total box. Then for each Data Field you want totaled select a Summary Function (see below).



Summary Functions:
· Sum: Totals the all of the data in the Data Field.
· Count: Returns the number of rows in the Data Field.
· Average: Takes the mean of the data in the Data Field.
· Minimum: Displays the lowest value in the Data Field.
· Maximum: Displays the highest value in the Data Field.
Data Headers
A check box will appear in the Summarize By box for each Data Category in the Sorts tab. To display a header for each value of a Data Field click on the associated Data Category in the Summarize By box. A Header Menu will appear.
· To include a Header check the box ‘Include Header at the beginning’. In order to select the text that will appear as the header value, use the Header dropdown to select a Data Field or use the Formula Editor Button ([image: image30.png]h3



) to create a formula.
· Use the ‘Summarize by each unique’ dropdown to specify if the header should repeat based on a specific field or all the keys of a Category.
· Check the box ‘Include Total at the end’ to have a sub-total created for this Category.
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Page Header

To display information on the top of each page, click ‘Page Header’ below the ‘Summarize By’ box. A Page Header Menu will appear.
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· Check the box ‘Include Title at the top of every page’ to display the name of the report on each page. If an image is also included, use the position dropdown to set where the title should appear and the number of columns it should span.

· Use the ‘Change Image’ button to upload an image to display at the top of each page. If a title is also included, use the position dropdown to set where the image should appear and the number of columns it should span.
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Footers

To display information on the bottom of each page, click ‘Page Footer’ below the ‘Summarize By’ box. A Page Footer Menu will appear.
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· Check the box ‘Include page number at the bottom of every page’ to display the page number on each page. If an image is also included, use the position dropdown to set where the page number should appear and the number of columns it should span.

· Use the Change Image button to upload an image to display at the bottom of each page. If the page number is also included, use the position dropdown to set where the image should appear and the number of columns it should span.
[image: image35.png]Page Number
) Include page number at the bottom of every page

Poston:  Numberofcobnsto span
Left v 1

Image-

0 Include image at the bottom of every page N

Posttion: ‘Number of columns to span: o
Rgt v| 1 [ Image
Selected





Preview
At the bottom of the layout tab a preview will display how the report will appear based on the fields that have been added.  You can increase the size of the preview or hide it all together by dragging or clicking the resize button ([image: image36.png]


).
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New CrossTab Wizard

The New CrossTab Wizard is an interactive tool which will walk through the process of creating a new report. All of the settings in the New Report Wizard can be modified in the Report Designer after the report is created.

To navigate the wizard either click the desired tab or use the buttons at the bottom.
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The New Report Wizard has four sub tabs. The Name, Categories and Layout tabs must be completed while the other tabs are optional.
Name Tab

In the Name tab enter a report name and click on the Folder where the report will be saved.
The report name can be up to 255 characters. Avoid special characters such as ? : / \ * “ < >.
A report’s description appears at the bottom of the Main Menu when it is selected. The description text is also used when searching for a report.
NOTE. You cannot create a report inside a folder that is read-only ([image: image39.png]


 ).
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Categories Tab

In the Categories tab select the Data Categories that you would like to have access to on the report. It is important to understand two terms: Data Category and Data Field.
Data Category – A Data Category is a data object that has several attributes. Ex. Students is a category; each student has an ID, a major, an advisor etc.
Data Field – A Data Field is a single attribute within a category. Ex. Students.ID is the numeric value that identifies a specific student.
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· To add a Data Category either drag and drop it to the ‘Category Name’ Column, use the ‘Add’ button or double-click it.
· To search for a specific Data Category or folder, type its name into the Search box.

· To see what Data Fields are in a Data Category click the information button ([image: image42.png]


).
· Check the ‘Suppress Duplicates’ box to suppress duplicate information from appearing on the report.

· To remove a Data Category click the delete button ([image: image43.png]


).

Filters Tab

In the Filters Tab create statements to filter the data at runtime.
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There is no limit to the number of filters that can be defined. Filters can be numeric (up to eight decimals) or alphanumeric.
· To filter a Data Field either drag and drop it to the ‘Filter By’ column, use the ‘Add’ button or double-click it. 
· Use the up and down arrows to indicate the filter priority. 

· To remove a filter click the delete button ([image: image45.png]


).

· Set the operator (equal to, less than, one of, etc.) by selecting it from the operator drop-down.

· Set the filter value by either entering it manually or selecting a value from the drop-down. If the Data Field is a date the calendar and function buttons can be used to select a value.
· Check ‘Prompt for Value’ to allow the filter to be modified at the time the report is executed.
· Select ‘AND With Next Filter’ to require that the selected filter and the one below it are both true. Choose ‘OR With Next Filter’ to require that either be true.
· Check ‘Group With Next Filter’ to specify the precedence of the filters. Filters can be nested indefinitely by using the following keyboard shortcuts while a filter is selected:

· Ctrl + [ adds an open-parenthesis before the selected filter.
· Ctrl + ] adds a close-parenthesis after the selected filter.
· Ctrl + Shift + [ removes an open-parenthesis from before the selected filter.
· Ctrl + Shift + ] removes a close-parenthesis from after the selected filter. 
 
Layout Tab

In the Layout tab design the CrossTab by moving Data Fields into the Row Header, Column Header and Tabulation Data panels.
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Row Headers
Row Headers expand a CrossTab vertically. A CrossTab has a row for each unique value of a Row Header. For example if you were using sales data you may have the Row Headers Category.CategoryName and Products.ProductName to provide rows for each product grouped by category (see image below).
· To add a Row Header either drag and drop it to the ‘Row Header Source’ panel or use the ‘Add Row Header’ button ([image: image47.png]


).
· Click the Formula Editor Button ([image: image48.png]h3



) to insert a formula into the Row Header.
· Click the Edit Header button ([image: image49.png]


) to open the header options menu. In the Header Options Menu you can: 
· Set a Label for the Row Header. This label will appear at the top of the CrossTab.
· Select a Sorting Method and direction.
· None – Does not sort the Row Headers.
· Header Value (Text) – Sorts the Row Header by its values as though they are text.

· Header Value (Number) – Sorts the Row Header by its values as though they are numbers.

· Tabular Totals – Sorts the Row Header by the totals of the Tabulation Data.

NOTE. If there is more than one Row Header the Header Options Menu for the top most Row Header will have Options for sub-totals of Tabulation Data.
· Select where to display subtotals by using the Placement dropdown.
· None – Does not display subtotals.

· Top – Displays subtotals above the Tabulation Data for each Row Header value.
· Bottom – Displays subtotals below the Tabulation Data for each Row Header value.

· Set a label for the subtotals.
· Use the up and down arrows to rearrange the order of the Row Headers.
· To remove a Row Header click the delete button ([image: image50.png]


).
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Column Headers
Column Headers expand a CrossTab horizontally. A CrossTab has a column for each unique value of a Column Header. For example if you were using sales data you may have the Column Headers ‘Year({Order.OrderDate})’ and ‘Month({Orders.OrderDate})’ to provide columns for each month grouped by year (see the image below).
· To add a Column Header either drag and drop it to the ‘Column Header Source’ panel or use the ‘Add Column Header’ button ([image: image52.png]


).
· Click the Formula Editor Button ([image: image53.png]h3



) to insert a formula into the Column Header.
· Click the Edit Header button ([image: image54.png]


) to open the Header Options menu. In the Header Options Menu you can:

· Set a Label for the Column Header to appear at the top of the CrossTab.

· Select a Sorting Method and direction.

· None – Does not sort the Column Headers.
· Header Value (Text) – Sorts the Column Header by its values as though they are text.

· Header Value (Number) – Sorts the Column Header by its values as though they are numbers.

· Tabular Totals – Sorts the Column Header by the totals of the Tabulation Data.

NOTE. If there is more than one Column Header the Header Options Menu for the top most Column Header will have Options for sub-totals of Tabulation Data.

· Select where to display subtotals by using the Placement dropdown.

· None – Does not display subtotals.

· Left – Displays subtotals to the left of the Tabulation Data for each Column Header value.

· Right – Displays subtotals to the right of the Tabulation Data for each Column Header value.

· Set a label for the subtotals.

· Use the up and down arrows to rearrange the order of the Column Headers.
· To remove a Column Header click the delete button ([image: image55.png]


).
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Tabulation Data

Tabulation Data provides information when data exists for both the Column Header and Row Header values. For example if you have a Row Header on products and a Column Header on the month, then Tabulation Data of Orders.OrderID may use the Count function to display how many orders contained each product each month.
· To add a Tabulation Data either drag and drop it to the ‘Tabulation Data’ panel or use the ‘Add Tabulation Data’ button ([image: image57.png]


).
· Click the Formula Editor Button ([image: image58.png]h3



) to insert a formula into the Tabulation Data.
· Click the Edit Tabulation button ([image: image59.png]


) to open the Tabulation Options menu. In the Tabulation Options Menu you can: 
· Set a Label for the Tabulation Row to appear at the beginning of each row.

· Use the Method dropdown to select the summary function to be applied to the Tabulation Data.
· Sum: Totals the Tabulation Data.

· Count: Counts the Tabulation Data.

· Average: Takes the mean of the Tabulation Data.

· Minimum: Displays the lowest value in the Tabulation Data.

· Maximum: Displays the highest value in the Tabulation Data. 

· None: Displays the value of the Tabulation Data without applying any formula.

· Use the Value dropdown to select how the Tabulation Data should be displayed.

· Aggregate: Display the result of the selected Method.

· Percent of Row: Display the result of the selected method as a percentage of the row total.

· Percent of Colum: Display the result of the selected method as a percentage of the column total.
· Use the up and down arrows to rearrange the order of the Tabulation Data.
· To remove a Tabulation Data click the delete button ([image: image60.png]


).
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CrossTab Themes

The Theme dropdown can be used to quickly style the CrossTab using a predefined theme. Further styling can be done in the Report Designer.
CrossTab Options

Settings that affect the entire CrossTab are controlled in the CrossTab Options Menu. Open the CrossTab Options Menu by clicking the Options button ([image: image62.png]% Options



). Using this menu you can adjust the following settings:
General 
· Use the Row Headers Placement dropdown to determine how the Row Headers are displayed.

· Columns – Display the Row Headers in columns from left to right in the order they are in the Row Header Source panel.
· Hierarchical – Display Row Headers in a hierarchical structure using indentation to display their order.
· Check ‘Repeat CrossTab Header every new page’ to repeat Row Header labels and Column Headers on each new page.
Grand Total Row

· To get a total for each column, select ‘Top’ or ‘Bottom’ from the Placement dropdown in the Grand Total Row section and provide a label in the Label text box. 
Grand Total Column

· To get a total for each row, select ‘Top’ or ‘Bottom’ from the Placement dropdown in the Grand Total Column section and provide a label in the Label text box. 
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Preview

At the bottom of the layout tab a preview will display how the Crosstab will appear based on the fields that have been added.  You can increase the size of the preview or hide it all together by dragging or clicking the resize button ([image: image64.png]


).
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Express Report Wizard

The Express Report Wizard is an interactive tool which allows you to quickly create and edit Express Reports.
To navigate the wizard either click the desired tab or use the buttons at the bottom.

To Save an Express Report click the save button.
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The Express Report Wizard has six sub tabs. The Name, Categories and Layout tabs must be completed while the other tabs are optional.
Name Tab
In the Name tab enter a report name and click on the Folder where the report will be saved.
The report name can be up to 255 characters. Avoid special characters such as ? : / \ * “ < >.
A report’s description appears at the bottom of the Main Menu when it is selected. The description text is also used when searching for a report.
NOTE. You cannot create a report inside a folder that is read-only ([image: image67.png]


 ).
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Categories Tab

In the Categories tab select the Data Categories that you would like to have access to on the report. It is important to understand two terms: Data Category and Data Field.
Data Category – A Data Category is a data object that has several attributes. Ex. Orders is a category; each order has an ID, a date, a customer etc.
Data Field – A Data Field is a single attribute within a category. Ex. Orders.OrderID is numeric value that identifies a specific order.
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· To add a Data Category either drag and drop it to the ‘Category Name’ Column, use the ‘Add’ button or double-click it.
· To search for a specific Data Category or folder, type its name into the Search box.
· To see what Data Fields are in a Data Category click the information button ([image: image70.png]


).
· Check the ‘Suppress Duplicates’ box to suppress duplicate information from appearing on the report.
· To remove a Data Category click the delete button ([image: image71.png]


).

Sorts Tab

In the Sorts tab specify which Data Fields will be used to determine the order of data on the report.
[image: image72.png]] EL Sort By [ _SonOwer T [ |

X Cancel < Previous  Next > ## Save and Close





· To sort by a Data Field either drag and drop it to the ‘Sort By’ Column, use the ‘Add’ button or double-click it.
· You can sort each Data Field in ascending (A- Z) or descending (Z-A) order.
· Use the up and down arrows to indicate the sort priority.
· To remove a sort click the delete button ([image: image73.png]


).

Filters Tab

In the Filters Tab create statements that will be used to filter the data when you execute the report.
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There is no limit to the number of filters that can be defined. Filters can be numeric (up to eight decimals) or alphanumeric.
· To filter a Data Field either drag and drop it to the ‘Filter By’ column, use the ‘Add’ button or double-click it.
· Use the up and down arrows to indicate the filter priority.
· To remove a filter click the delete button ([image: image75.png]


).
· Set the operator (equal to, less than, one of, etc.) by selecting it from the operator drop-down.
· Set the filter value by either entering it manually or selecting a value from the drop-down. If the Data Field is a date the calendar and function buttons can be used to select a value.
· Check ‘Prompt for Value’ to allow the filter to be modified at the time the report is executed.
· Select ‘AND With Next Filter’ to require that the selected filter and the one below it are both true. Choose ‘OR With Next Filter’ to require that either be true.
· Check ‘Group With Next Filter’ to specify the precedence of the filters. Filters can be nested indefinitely by using the following keyboard shortcuts while a filter is selected:

· Ctrl + [ adds an open-parenthesis before the selected filter.
· Ctrl + ] adds a close-parenthesis after the selected filter.
· Ctrl + Shift + [ removes an open-parenthesis from before the selected filter.
· Ctrl + Shift + ] removes a close-parenthesis from after the selected filter. 
 
Layout Tab

In the Layout tab select which Data Fields that will appear on the report. For each Data Field chosen, the report will automatically create a column header and the Data Field. Additionally, sub-totals, grand totals, and page header/footers can be created.
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Display Data

· To place a Data Field on the report either drag and drop it to the ‘Data Field’ column, use the ‘Add’ button or double-click it.
· To add blank columns that can be typed in click the ‘Add Blank’ button ([image: image77.png]# Add Blank



). You can enter text into a blank column.
· Use the up and down arrows to indicate the order the Data Fields should appear on the report. The Data Field at the top will appear on as the left most column of the report.
· The Summary Function column is used to make sub-totals and grand totals. See Sub-Totals and Grand Totals for more information.
· To remove a Data Field click the delete button ([image: image78.png]


).

For each Data Field added in the Sorts tab a checkbox will appear in the Summarize By box. Using the ‘Summarize By’ box you can display sub-totals, grand totals or headers for each unique value of a Data Field.
Sub-Totals and Grand Totals

· To display sub-totals, check the box of the category you want sub-totals for. Then for each Data Field you want totaled select a Summary Function (see below).

· To display grand totals check the Grand Total box. Then for each Data Field you want totaled select a Summary Function (see below).



Summary Functions:

· Sum: Totals the all of the data in the Data Field.

· Count: Returns the number of rows in the Data Field.

· Average: Takes the mean of the data in the Data Field.

· Minimum: Displays the lowest value in the Data Field.

· Maximum: Displays the highest value in the Data Field. 
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Data Headers

To display a header for each value of a Data Field click on the associated Data Category in the Summarize By box and a Header Menu will appear.
· To include a blank row before each unique value of the selected Data Field check the box ‘Add space before each unique item’.
· To include a Header check the box ‘Include Header at the beginning’. In order to select the text that will appear as the header value, use the Header Text dropdown to select a Data Field or use the Formula Editor Button ([image: image80.png]h3



) to create a formula.
· Use the ‘Summarize by each unique’ dropdown to specify if the header should repeat based on a specific Data Field or if it should repeat for all of the keys of a Category. 

· Check the box ‘Include Total at the end’ to have a sub-total created for this Category.
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Page Header

To display information on the top of each page, click ‘Page Header’ below the ‘Summarize By’ box. A Page Header Menu will appear.
[image: image82.png]‘Summarize By
[Cprofessors

Page Header (] Page Footer (] Grand Total





· Check the box ‘Include Title at the top of every page’ to display the name of the report on each page. If an image is also included, use the position dropdown to set where the title should appear and the number of columns it should span.

· Use the ‘Change Image’ button to upload an image to display at the top of each page. If a title is also included, use the position dropdown to set where the image should appear and the number of columns it should span.
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Footers

To display information on the bottom of each page, click ‘Page Footer’ below the ‘Summarize By’ box. A Page Footer Menu will appear.
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· Check the box ‘Include page number at the bottom of every page’ to display the page number on each page. If an image is also included, use the position dropdown to set where the page number should appear and the number of columns it should span.

· Use the ‘Change Image’ button to upload an image to display at the bottom of each page. If the page number is also included, use the position dropdown to set where the image should appear and the number of columns it should span.
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Preview

At the bottom of the layout tab a preview will display how the report will appear based on the fields that have been added. You can increase the size of the preview or hide it all together by dragging or clicking the resize button ([image: image86.png]


).
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Styling Express Reports

Above the preview is a toolbar. This toolbar can be used to stylize the Express Report. In order to utilize this toolbar select the cell(s) you want to modify from the preview.
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The following icons are available in the toolbar:
Undo/Redo – can undo or redo the last change made. You can also use Ctrl+Z /Ctrl+Y respectively. [image: image89.png]v N




Layout Options – see Layout Options for more information. [image: image90.png]



Font – see Font for more information. [image: image91.png]Avrial




Foreground & Background Color – see Color for more information. [image: image92.png]Al




Number/Date Format – see Formatting Cells for more information. [image: image93.png]



Border Color – see Formatting Cells for more information. [image: image94.png]



Alignment – see Alignment for more information. [image: image95.png]



Theme – see Theme for more information. [image: image96.png]Theme: | Custom




Layout Options

In Layout Options you can hide the detail information and set row shading.
· Check ‘Suppress Detail Rows’ to only display Sub-Totals, Grand Totals, Data Headers & Page Headers/Footers.

· To add row shading click the ‘New’ button and select a color from the color dropdown or enter a hex value.


NOTE. Row Shading is only applied to the detail rows that contain Data Fields.
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Express Report Themes
The Theme dropdown can be used to quickly style the report using one of the pre-defined themes. After selecting a Theme styling can still be modified. See Styling Express Reports for more information.
Options Tab

The Options tab allows you to control various report option settings.
General Options
· From the ‘Include Setup’ menu select Top or Bottom to display the data categories, sorts and filters at either the beginning or end of the report.
· Select which type of Filter menu to display when executing a report that has prompt for value filters. 
· Default – Display the default type of filter execution window.
· Standard – Display the standard filter execution window.
· Simple with Operator – Display a simplified filter execution window that only allows the operator and value to be changed.
· Simple without Operator – Display a simplified filter window that only allows the filter value to be changed.
· Check ‘Always Show Filter on Execution’ to show the filter menu and allow changes to be made each time the report is executed.
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Export Options
General Export Options

· Use the Default Export Type drop-down to specify the default format for the report. 

· Output types may be disabled by unchecking the boxes for ‘Allowed Export Types’.
HTML Options

· Uncheck ‘Show Grid’ to disable grid lines.

· Uncheck ‘Simulate PDF’ to have the report appear as though it is not on a page.
Excel Options
· Check ‘Suppress Formatting’ to prevent the report formatting from exporting to Excel.

Page Options
· Specify the size of the report in the ‘Page Size’ drop-down. Default is Letter.

· Set the orientation for the report in the ‘Orientation’ menu. Default is Portrait.

· Check ‘Fit to Page Width’ to scale all columns to fit the width of the page.
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Advanced Options
In the Advanced Options an Express Report can be converted to a Standard Report.

IMPORTANT. This CANNOT be undone.
· Click the ‘Convert simple report to a standard report’ button to convert an Express Report to a Standard Report.
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Searching Reports
To search for a specific report, enter the terms that you want to search for in the search box. All reports that have the search terms in either the name or the description will appear. To see all the reports click the Clear button ([image: image101.png]
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You can use the Settings dropdown to choose whether to search either the report names alone, or the names and descriptions of the reports.
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Folder Management

NOTE. If you do not see a Manage Folders button in the Main Menu then you do not have folder management privileges and should contact your administrator.
In the Main Menu click the Manage Folders button. A drop-down menu will appear. Use these icons to create, rename, or delete folders and sub folders.
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· To create a new folder click the ‘Add Root Folder’ button ([image: image105.png]


).
· To create a sub folder, first select the parent folder and then click the ‘Add Sub Folder’ button ([image: image106.png]


).

· To rename a folder select it then click the ‘Rename’ button. ([image: image107.png]


).

· To delete a folder select it then click the ‘Delete’ button ([image: image108.png]


). The folder must be empty in order to delete it.
Editing Reports

To edit an existing report:

1. On the Main Menu, select the report you want to edit.
2. Click the Edit button ([image: image109.png]


) or double click the report.

· For Standard Reports the Report Designer will open in a new tab.
· If you selected an Express Report the Express Report Wizard will open in a new tab.

· If you selected a Chained Report the Chained Report Wizard will open in a new tab.
NOTE. You cannot edit any report that is read-only ([image: image110.png]


). You can duplicate the report into an unlocked folder and edit the duplicate.
Report Designer

The Report Designer can be used to add data, charts, formulas, sorts, filters and many other features to a report.
The Report Designer has three parts: the Design Grid, the Data Menu and the Toolbar.
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Design Grid

In the design grid you can:
· Add and delete rows, columns and sections.
· Enter Data Fields, text and formulas.
· Drag and drop data and text into different sections, rows or columns.
Data Menu

Through the data menu you can:

· Drag and drop Data Fields onto the report.

Click the arrows ( [image: image112.png]


 ) to hide the data menu. The arrows are located between the data menu and the design grid.
Toolbar

Using the toolbar you can:

· Rename the report. 

· Add, modify or remove sorts and filters. 

· Format cells’ font, font size, alignment, color and borders. 

· Use the Formula Editor to create complex functions. 

· Insert charts, gauges, and images. 

· Link reports, allowing users to drilldown for more detail. 

· Save the report. 

· Execute the report as HTML, Excel, CVS, RTF or PDF. 

· Give a report access to new Data Categories or remove Data Categories from the report. 

· Add an Action Event. (If you do not see this option, your administrator may have disabled it).
Design Grid

In the design grid you can:
· Add and delete rows, columns and sections.
· Enter data fields, text and formulas.
· Drag and drop fields into different sections, rows or columns.
Sections

Sections dictate how the data appears in a report. There are five types of sections: page, report, details, group and repeating group.
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Page Header & [image: image114.png]


Page Footer – The rows in the Page Header section appear at the top of every page of a report. Typically, the Page Header section is used to designate column headers for a report. The rows in the Page Footer section appear at the bottom of every page of a report. Typically, the Page Footer sections are used to display the page number, or confidentiality notices for a report.

NOTE. Formulas and calculations should not be made in the Page Footer section.
NOTE. If you are printing a report remember that Excel output does not have pages. Page Headers will appear only once at the beginning of the report. Reports executed as HTML will display Page Headers similarly unless ‘Simulate PDF’ is checked in the Options menu.
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Report Header & [image: image116.png]


Report Footer – The rows in the Report Header appear at the beginning of a report. Typically, these rows display the title of a report. The rows in the Report Footer appear at the end of a report. Typically, the Report Footer displays grand totals and summary information for the report.
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Detail – The Detail section is the main section of most reports. When the report is executed the Details Section creates a row for each element in the Data Categories. For example if the Detail section contains the Data Field Orders.OrderId, the report will display each Order Id on a separate row.
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Group Header & [image: image119.png]


Group Footer – Group Header/Footer sections require a sort on a Data Field. The rows in a Group Header section will appear above the Detail section for each unique value of the sorted Data Field. Typically, Group Header sections are used to display data as labels. For example a report may contain a Group Header on Orders.OrderDate and display Orders.OrderId in the Detail section. The output would display each date with orders that occurred on that date below them.
The rows in a Group Footer section will appear below the Detail section for each unique value of the sorted Data Field. Typically, Group Footer sections are used to calculate subtotals. For example a report may contain a Group Footer on Orders.OrderDate which displays the number of orders made on each date.
NOTE. Group Header/Footer sections can also be set to display rows for each value of a formula instead of a Data Field. (Ex. The report may be sorted on the Data Field Orders.OrderDate but the report should show subtotals for each month. A Group Footer on the formula ‘=Month({Orders.OrderDate})’ will display rows containing subtotals for each month.)
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Repeating Groups – Repeating Groups require a sort on a Data Field. Repeating Groups have their own header, details and footer subsections. Repeating Groups should only be used when the data has multiple one-to-many relationships and each should be rendered completely before the other. 
(Ex. Each Professor can teach multiple classes and advise multiple students. For each professor you want to see all the classes they teach and then all the students they advise.)
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Using Sections

Sections can be added, deleted, modified, moved, and assigned shading.
Adding Sections
1. Click anywhere in the Section Column.
2. Hover your mouse over ‘Add Section,’ then select the type of section you would like to add.
Deleting Sections
1. In the Section Column click on the section you want to delete.

2. Click ‘Delete Section’.
Modify Sections (Group Header/Footers and Repeating Groups only)
1. In the Section Column click on the section you want to modify.

2. Click ‘Modify Section’. This will bring up a ‘Modify Group Section’ Menu.
3. Select from the drop-down the desired Data Field for the group to use.

4. Click OK.
Section Shading
1. In the Section Column click on the section that you want to Shade.

2. Click ‘Section Shading’. This will bring up a menu.

3. Click ‘New’ to add a color to the shading. 
4. Click the color box to select a color or enter a hex value.
5. Click OK.
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Columns and Rows
Columns and rows of cells can be added, modified or removed as described below.
Columns
· To select a group of columns, hold the SHIFT key and then click the beginning and ending column. 

· Non-contiguous columns can be selected by holding the CTRL key and clicking the desired columns.

· A column can be resized by dragging its right edge horizontally.
· Clicking on a column (or selected group) will display a menu where you can:
· Insert a new column.

· Delete the selected column.

· Set its width to be identical with the other selected columns.

· Hide the selected column.

· Set Column Info to make the label the column and/or make it sortable on HTML reports.
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Sorting by Columns on HTML

While viewing reports as HTML, a user can click the bar at the top of the report to sort by a column. For Express Reports this is handled automatically but must be enabled for Standard and Crosstab Reports.
To make a column sortable in HTML
· Click on the column and select Column Info…

· Provide the column with a label that will appear in the Interactive HTML Dock.
· From the Sort dropdown select the Data Field to be used for sorting, or provide a formula by clicking the formula button ([image: image124.png]h3



).

NOTE. HTML Column Sorts are applied AFTER any sorts defined in the Sorts Menu.
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· Click on the column again to set a default sort direction.
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Rows

· To select a group of rows, hold the SHIFT key then click the top and bottom row.
· Non-contiguous rows can be selected by holding the CTRL key and clicking the desired rows.
· A row can be resized by dragging its bottom edge vertically.
· Clicking on a row (or selected group) will display a menu where you can:

· Insert a new row.

· Delete the selected row.

· Set its height to be automatically controlled.

· Suppress the row from appearing on the report.
· Insert a page break.



NOTE. Please see Using Page Breaks
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Cells

Cells are the containers for all the information in a report. Cells may contain text, images, charts, or links to other reports.
· To enter text into a cell, double-click and a text field will appear.

· To select cells either click or use the arrow keys.
· Groups of cells can be selected by holding the SHIFT key and clicking on another cell. All the cells in between the two will be selected.

· Non-contiguous cells can be selected by holding the CTRL key and clicking the desired cells.

· A cell can be copied by holding the CTRL key, then dragging and dropping it into a new cell.

· Adjacent cells can be merged and unmerged using the Merge/Split Cell buttons in the Toolbar.
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Using Page Breaks

For a Page Break to occur at the beginning of each element of a Data Field, place a page break on the top row of Group Header Section for that Data Field. See Sections for more detail on Group Headers Sections.
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Creating Collapsible Rows

A Group Section can be set to display as collapsed by default on HTML export. This causes the contents of the section to be suppressed and individually expandable for each change in Header. Collapsible rows are supported in the standard or Interactive HTML viewer. Non-HTML export formats will ignore Collapsible Rows.
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Left-click on an arrow next to a Collapsible Row to expand or collapse the group.
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Right-click on an arrow next to a Collapsible Row to see additional display options:
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Expand  will expand the selected top-level group. This is the same behavior as a left-click.

Collapse will collapse the selected top-level group. The state of the sub-groups is preserved.

Expand Group will expand the selected top-level group and all sub-groups within that group.

Collapse Group will collapse the selected top-level group and all sub-groups within that group.

Expand All will expand every group and sub-group on the page.

Collapse All  will collapse every group and sub-group on the page.

To create a Collapsible Row, first open the desired report in the Report Designer. Click on the desired row number in a Group Header Section and select Collapse Rows in the dropdown menu.
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A Collapsible Row is indicated by a green arrow at the bottom right of the row number cell:
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Properties of a Collapsible Row
Collapsible Rows have the following properties when exported to HTML:
· Collapsible Rows display as collapsed whenever the Report is exported, or altered using Interactive HTML.
NOTE. Collapsed or expanded state cannot be saved to the Interactive HTML User Report preferences.

· Page Breaks below a Collapsible Row are ignored.

· Expanding a Collapsible Row will not alter the Report pagination.
See Sections for more detail on Group Headers Sections.
See Interacting with HTML Reports for more information on Interactive HTML.
Data Menu

The data menu holds the data that you can put into a report.
Adding Data Fields to a Report

To add a Data Field to a report, select the appropriate Data Category at the top of the menu. Drag and drop the Data Field from the menu to a cell in the Design Grid.
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Alternatively, a Data Field can be put into a cell by typing Data Category Name (dot) Data Field Name. (Ex. Orders.OrderID).
To access other Data Categories see the section on Data Categories.
Toolbar
The toolbar contains the buttons and menus used to modify the report. Modifications can include aesthetic formatting, inserting formulas and images, linking reports and much more.
The toolbar begins with a drop-down menu. This menu controls changes that affect the entire report such as renaming or filtering. All other buttons on the toolbar require a cell (or cells) in the design grid be selected.
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Saving Reports

The report can be saved by clicking the save button ([image: image137.png]


). The report will also be saved anytime it is executed.

Undo/Redo

Any action on a report can be undone by click ([image: image138.png]


) or pressing CTRL + Z. Undone actions can be redone by clicking ([image: image139.png]


) or pressing CTRL + Y.
Font & Alignment Options

The text of each cell can be formatted using drop-down menus and buttons in the toolbar. A cell or multiple cells must be selected for these tools to be used.
Font

· To change the font use the drop-down ([image: image140.png]Arial



). The font names appear in the style that they represent. 

· The buttons B, I and U, make the font bold, italicized and underlined, respectively.
· Text size can be controlled using the up and down arrows on font size menu ([image: image141.png](=



).
Color

· To change the text color, click the Foreground Color button ([image: image142.png]


 ) and then select a color or enter a hex value into the Foreground box. Click the clear button to revert to the default color ([image: image143.png]


).
· To change the background color, click the Background Color button ([image: image144.png]


) and then select a color or enter a hex value into the Background box. Click the clear button to revert to the default color ([image: image145.png]


).
Alignment
· Text can be aligned to the top, center, or bottom of a cell using the vertical alignment buttons.
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· Text can be centered, justified or aligned to the left or right of a cell using the horizontal alignment buttons.
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· The wrap text button ([image: image148.png]


 ) will begin a new line if the text is longer than the width of cell.
Formatting Cells

Cells can be formatted in the Cell Format Window. To open the window click the format cell button ([image: image149.png]


). The window has three tabs: Number, Border and Conditional.
NOTE. Cell formatting can be copied using the Format Paintbrush. Select the format you want to copy, click the format paintbrush button ( [image: image150.png]


) then click the cell you want to apply the formatting to.
Number
The Number tab allows you to set the format of numbers and dates.
· General: 
· General format automatically applies formatting to cell values.

· Number:
· Using the arrows you can specify how many decimals to display. You can also set the symbol to separate decimals from whole numbers. 

· Check the box ‘Use 1000 Separator’ to separate every 3 digits. You can set which symbol is used to separate digits.
· Check ‘Use Currency Symbols’ to have the currency sign appear in front of the number.
· Check ‘Append Percent Sign’ to have the symbol ‘%’ appear after the number.
· Check ‘Blank When Zero’ to leave the cell(s) blank if the value is zero.
· Check ‘Show ‘-’ Symbol’ to have a negative sign display in front of the number if it is negative.
· Check ‘Show Parenthesis’ to put ( ) around the number if it is negative.
· Selecting a color will make the number that color if it is negative.
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· Date:
· From the menu select the time/date format. (Ex. MM-yy will display a date as ‘Jun-97’).
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· Text: 
· Text format does not apply formatting to cell values.
Border
The Border tab allows you to alter the width and color of the cell edges.
· Uncheck ‘Make Borders Uniform’ to modify specific edges.
· To widen the borders either key in a value or use the arrows in the width box.
· To change the color either select a color from the drop-down or enter a Hex value.
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Conditional Formatting/Suppression
The Conditional Formatting tab allows you to set or modify the format of a cell based on formula you create.
· Click the Add button ([image: image154.png]Add



) to create a new conditional format. Each format must have an Action, and a Formula that evaluates to True or False. Some Actions require an Attribute such as a color or a number.
· Select an Action from the dropdown. This action will occur if the formula evaluates to True. Actions include:

· Foreground Color –Sets the foreground color of the cell.

Attribute: Color
· Background Color – Sets the background color of the cell.

Attribute: Color
· Font Size – Sets the size of the text.

Attribute: Number

· Bold – Bolds the text of the cell.

No Attribute

· Italic – Italicizes the text of the cell.

No Attribute

· Underline – Underlines the text of the cell.

No Attribute

· Horizontal Alignment –Aligns the text of the cell horizontally.

Attributes: Left, Center, Right, or Justify
· Vertical Alignment – Aligns the text of the cell vertically.

Attributes: Top, Bottom or Middle

· Suppress Row – Suppresses the row the cell is in.

No Attribute

· Suppress Section – Suppresses the entire section that contains the cell.

No Attribute

· Page Break – Starts a new page.

No Attribute

· Click the Formula Editor Button ([image: image155.png]h3



) to set the condition for the formula.
NOTE. The formula must evaluate to True or False. For conditional formatting the Formula Editor will have an add ‘Cell Value’ ([image: image156.png]% Cell Value



) button. This button adds the function CellValue() to the formula. This function returns the value of the cell that conditional format is being applied to.
NOTE. The formula is still calculated with respect to the section of the cell. For example for a cell in a report footer the formula {Order.Profit} > 1000 will return True if the last Order of the detail section profited more than 1,000. To make the condition see if the total profit was greater than 1,000 use the formula ‘Sum({Order.Profit})>1000’.

· Use the up and down arrows to change the priority of the formats. If two formats share a common action and are both True then the lower condition will be applied.
· To remove a format click the delete button ([image: image157.png]


).
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AutoSum

To quickly get a total on a Data Field, place the field in a Report or Group Footer and click the AutoSum button ([image: image159.png]


).  Alternatively, a sum can be created with the aggSum or Sum functions. See Formulas for more information.
NOTE. Do not use AutoSum on a cell with an aggregate formula such as aggSum.
[image: image160.png]BE B/ . cpEesras | |,

v BIUAD: Ermae i
Secton A(Productd) | B (Produciame) C (OfantyPerUnt) D (UndPrice)

o g Weekly Sgles
2 Productd  ProductName _QuitityPerunt_ Units n Stock

g
H

™ 2" to
Porocts et Proucs ol Cusyp rocucsUnkis

Footer: Products 4 Products UnitPrice:




Images

An image from your computer can be added to a cell using the Insert Image button ([image: image161.png]


). This opens the Insert Image window. Select the image you would like to insert and click ‘OK’.
Functions

Complex calculations can be done using Formulas. A formula can be added to a cell by keying it in manually or using the Formula Editor.  To open the Formula Editor click the Formula Editor Button ([image: image162.png]h3



).
Suppress Duplicates

You can suppress duplicate values of a Data Object from being displayed. Select the cell and click the Suppress Duplicate button ([image: image163.png]


). Ex. The two reports below are identical, except the right image has suppressed duplicates of the customer column.
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Charts Wizard
To insert a chart select a cell and then click the Insert Chart button ([image: image166.png]


). The Chart Wizard will appear. The Chart Wizard has three tabs: Appearance, Data and Labels.
NOTE. Charts should only be placed into a Group Header, Group Footer, Report Header or Report Footer sections.
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Appearance
In the Appearance tab select the type of chart, its size, its colors and where to display the legend.
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· Select the chart type by clicking the icon that represents it. Check the ‘Use 3D Style’ box to make the chart three dimensional.

· There are three ways to set the size of the chart.

· Enter the height and width in the dimension boxes.

· Resize the chart by dragging the lower right corner in the preview.

· Check the box ‘Fit to Cell’.
· In the color drop-down either select a color theme or specify a linear range of colors. 
NOTE. The legend may overlap the chart if the size is too small.

There are two types of charts: single series and multi-series.
Single Series

Pie, Doughnut, Funnel, and Pyramid charts utilize a single Data Field to visually compare each element to the whole. (Ex. Each section of a pie chart may represent a region and the size of the section indicates how many people live in that region).
Pareto charts are a special type of single series chart generally used to highlight the most important element amongst a group. The bars of a Pareto chart will display in descending order while a line show the cumulative percentage of the total. You can read more about Pareto Charts here.

Multi-Series

Bar, Column, and Scatter charts display the values of one Data Field for each element of another Data Field. (Ex. A column chart will have a series of columns whose height indicates the number of customers in each region for each company).
Line and Spline charts display the values of one Data Field for each element of another Data Field, the second of which usually represents an interval of time.

Area Charts and Spline Area Charts are special types of Line and Spline charts which additionally display cumulative totals by filling in the areas underneath each Line or Spline.
Bubble Charts are a special type of Scatter chart which use a third Data Field to specify the size of the data points.
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Data
Use the Data tab to set specific data values and data labels for the chart.

· Use the Data Values drop-down to select the cell that contains the numeric value for the chart.

· Use the Data Labels drop-down to select the cell that contains the Data Field that names each element of the chart.
· Use the Y Values dropdown to select the cell containing the numeric values for the Y axis.

· Use the X Values dropdown to select the select the cell containing the numeric values for the X axis.
· From the Series Labels select the cell that contains the Data Field with the name of the series elements.
· (Bubble Charts) Use the Bubble Size dropdown to select the select the cell containing the numeric values for the size of the bubbles.

· (Bubble Charts) Use the Bubble Label dropdown to select the cell containing the Data Field with the name of each bubble.

· Use the ‘Sort data by’ dropdowns to specify the order of the chart data.
· Report Order – The chart will follow the order of the information on the report.

· Data Labels – The chart will be sorted by the data labels (either alphabetically or numerically).

· Data Values – The chart will be sorted by the data values.
· To ignore values that are too large or too small, enter a value into ‘Exclude values less/greater than/’ boxes.

· To manually set the axis values enter a value into the ‘Data Axis Minimum/Maximum Value’ boxes.

· Check the ‘Align Data Labels Across Series’ if you have multi-series data with common data labels among series.
NOTE. Consider charting house values as a function of location and building type.  We choose location as the series labels and building type as data labels.  Since each location uses the same building types, we check the 'Align Data Labels Across Series' box to align like data labels in the chart.  On the other hand, if we want to chart city populations where we use country name as the series labels and city name as the data labels, we leave the box unchecked.  This is because the data labels (city name) used for one series (country name) have no relation to those used in others.
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Labels
In the Labels tab set the visual options of the Chart.

· Chart Title: Enter the text you want to appear in at the top of the chart. 
· X-Axis Title: Enter the text you want to appear on the bottom of the chart.

· Y-Axis Title: Enter the text you want to appear on the left of the chart. 

· Point Labels: Use the dropdown to display the values of each element of the chart.

· Legend Position: Use the dropdown to specify where to show the legend on the chart.

· Label Font: To change the font, use the drop-down ([image: image171.png]Arial



). The font names appear in the style that they represent.
· Number Format…: Use the number format button menu to specify how data and axis labels should be formatted.
· Benchmark Lines…: Use the benchmark lines button menu to add horizontal benchmark lines at specific sections of the chart. See Benchmark Lines.
NOTE. Single Series charts only have a Chart Title. Multi-series charts additionally have X and Y Axis titles.
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Benchmark Lines

To add a Benchmark Line to a chart, open the Benchmark Lines menu by clicking the button in the Labels tab.

· Press the New button ([image: image173.png]& Hew



) for each new benchmark you wish to add to your chart.

· Label: Enter the text you want to appear as the label of the benchmark.
· Value: Specify the numeric value you would like to define as the benchmark. The benchmark line will display horizontally at this point on the Y axis.
· Color: Use the color drop-down to specify the color of the line.
· Line Style: Use the drop-down to specify the style of the line (either Solid or Dashed).

The resulting Benchmark Line will appear as so on the chart:
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Chart Types
The Charts Wizard supports a variety of single- and multi-series charts.
Pie

[image: image175.png]



Pie Charts are used to compare numerical data fields as portions of a whole. The area of each “slice” of the pie is proportional to the quantity it represents. Doughnut, Pyramid, and Funnel charts are variations of Pie Charts and are created in the same manner.
In the following example, the pie represents the total number of Orders and each slice represents the number of Orders per Customer.
NOTE. This report is making use of a Group Footer section to get a count of orders per customer. A Group Header may also be used. See Sections for more information.

NOTE. The following instructions also apply to Doughnut, Pyramid, and Funnel charts.
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· Add a Report Footer section to the report. Select all the cells in the Report Footer and click the Merge Cells button ([image: image177.png]


).

· Select the merged cell and click the Insert Chart button ([image: image178.png]


).

· In the Appearance tab:

· Click on the Pie Chart menu and select the Pie Chart option.

· Check the “Use 3D Style” box.
· Choose a size and color scheme.
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· In the Data tab:

· Set Data Values to the cell ‘=AggCount({Orders.OrderID})’. 

· Set Data Labels to the cell ‘Customers.CompanyName’.
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· In the Labels tab:

· Enter the text ‘Orders by Customer’ in the Chart Title.

· Set Point Labels to ‘Data Values’ and the Legend Position to ‘Right’.
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· Click Finish and execute the report as HTML.
This is how the chart will appear in the report designer:
NOTE. The chart will appear as a template in the report designer. It will not populate the field data. 
[image: image182.png]Section A 2]

Page Heater ! Pie Chart
Company Orders
Footer: Customers 3 TCustomers.CompanyName  =AggCount((Orders.OrderD})

Orders by Customer

a
-z

€ tem1

Renor Footer . © tem2

1o tems

© Mema
as -




This is how the chart will appear in the final report:


NOTE. This example has a filter on Customers for brevity.
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Doughnut
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Doughnut Charts are Pie Charts with a hollowed out center. They are created in a similar fashion.
See Pie Charts for instructions on creating a Doughnut Chart. The example will result in the following:
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Pyramid
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A Pyramid Chart is a variation of a Pie Chart in which the data sections are represented as “slices” on a Pyramid. The area of each slice is proportional to the quantity it represents.


NOTE. The width of each slice is not representative of the data.

See Pie Charts for instructions on creating a Pyramid Chart. The example will result in the following:
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Funnel
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A Funnel Chart is a variation of a Pie Chart in which the data sections are represented as “slices” on a Funnel. The area of each slice is proportional to the quantity it represents. It can be thought of as a “reverse” Pyramid Chart.
NOTE. The width of each slice is not representative of the data.

See Pie Charts for instructions on creating a Funnel Chart. The example will result in the following:
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Line
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Line Charts display a series of data points connected by straight lines. They are often used to display a trend in data over intervals of time. The vertical axis shows the categories being compared. The horizontal axis shows the numerical value for each category.
In the following example, each line represents the total number of Orders per Year per Company.

NOTE. This report is making use of a Group Footer section to get a count of orders per year. A Group Header may also be used. See Sections for more information.

The following instructions also apply to Spline, Area, and Spline Area charts.
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· Add a Report Footer section to the report. Select all the cells in the Report Footer and click the Merge Cells button ([image: image192.png]


).

· Select the merged cell and click the Insert Chart button ([image: image193.png]


).

· In the Appearance tab:

· Click on the Line Chart menu and select the Line Chart option.

· Choose a size and color scheme.
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· In the Data tab:

· Set Data Values to the cell ‘=AggCount({Orders.OrderID})’. 

· Set Data Labels to the cell ‘=Year({Orders.OrderDate})’.

· Set Series Labels to the cell ‘Customers.CompanyName’.
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· In the Labels tab:

· Enter the text ‘Yearly Orders’ in the Chart Title.

· Enter the text ‘Year’ in the X-Axis Title.

· Enter the text ‘Orders’ in the Y-Axis Title.
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· Click Finish and execute the report as HTML.

This is how the chart will appear in the report designer:
NOTE. The chart will appear as a template in the report designer. It will not populate the field data.
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This is how the chart will appear in the final report:


NOTE. This example has a filter on Customers for brevity.
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Spline
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Spline Charts display a series of data points connected by a fitted curve. They can be thought of as a variation of a Line Chart and are created in a similar fashion.
NOTE. The curve between data points is estimation; it does not represent actual data values.

See Line Charts for instructions on creating a Spline Chart. The example will result in the following:
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Area

[image: image201.png]



Area Charts are line charts in which the area below each line is filled in. They are generally used to compare the cumulative totals of different Data Fields over time. They can be thought of as a variation of a Line Chart and are created in a similar fashion.

See Line Charts for instructions on creating an Area Chart. The example will result in the following:
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Spline Area Charts are spline charts in which the area below each spline is filled in. They are generally used to compare the cumulative totals of different Data Fields over time. They can be thought of as a variation of a Line Chart and are created in a similar fashion.

See Line Charts for instructions on creating a Spline Area Chart. The example will result in the following:
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Bar
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Bar Charts use bars to compare data between different categories. The X-Axis shows the categories being compared. The Y-Axis shows the numerical value for each category.
In the following example, each bar represents the total number of Orders per Employee per Company.

NOTE. The report designer here is making use of a Group Footer section and two sorts to get a count of orders by customer per employee. See Sections for more information.

NOTE. The following instructions also apply to Stacked Bar, 100% Stacked Bar, Column, Stacked Column, and 100% Stacked Column charts.
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· Add a Report Footer section to the report. Select all the cells in the Report Footer and click the Merge Cells button ([image: image207.png]


).

· Select the merged cell and click the Insert Chart button ([image: image208.png]


).

· In the Appearance tab:

· Click on the Bar Chart menu and select the Bar Chart option.

· Check the “Use 3D Style” box.

· Choose a size and color scheme.
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· In the Data tab:

· Set Data Values to the cell ‘=AggCount({Orders.OrderID})’. 

· Set Data Labels to the cell ‘=Customers.CompanyName’.

· Set Series Labels to the cell ‘Employees.LastName’.
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· In the Labels tab:

· Enter the text ‘Orders by Customer’ in the Chart Title.

· Enter the text ‘Customer’ in the X-Axis Title.

· Enter the text ‘Orders’ in the Y-Axis Title.
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· Click Finish and execute the report as HTML.

This is how the chart will appear in the report designer:
NOTE. The chart will appear as a template in the report designer. It will not populate the field data.
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This is how the chart will appear in the final report:


NOTE. This example has a filter on Customers for brevity.
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Stacked Bar
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Stacked Bar Charts are Bar Charts which stack each data field in a group together on a single horizontal bar. Each bar represents a grouped Data Field, and each slice of the bar represents a data value in the group. They can be thought of as a variation of a Bar Chart and are created in a similar fashion.
See Bar Charts for instructions on creating a Stacked Bar Chart. The example will result in the following:
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100% Stacked Bar
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100% Stacked Bar Charts are Bar Charts which calculate the relative proportion for each data field in a group, and stack them together on a single horizontal bar so that they add up to 100%. Each bar represents a grouped Data Field, and each slice of the bar represents the proportion of a data value. 100% Stacked Bar Charts can be thought of as a variation of a Bar Chart and are created in a similar fashion.
See Bar Charts for instructions on creating a 100% Stacked Bar Chart. The example will result in the following:
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Column
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Column Charts use vertical bars to compare data between different categories. The X-Axis shows the categories being compared. The Y-Axis shows the numerical value for each category. They can be thought of as a variation of a Bar Chart and are created in a similar fashion.
See Bar Charts for instructions on creating a Column Chart. The example will result in the following:
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Stacked Column
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Stacked Column Charts are Bar Charts which stack each data field in a group together on a single vertical bar. Each bar represents a grouped Data Field, and each slice of the bar represents a data value in the group. They can be thought of as a variation of a Bar Chart and are created in a similar fashion.
See Bar Charts for instructions on creating a Stacked Column Chart. The example will result in the following:
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100% Stacked Column
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100% Stacked Column Charts are Bar Charts which calculate the relative proportion for each data field in a group, and stack them together on a single vertical bar so that they add up to 100%. Each bar represents a grouped Data Field, and each slice of the bar represents the proportion of a data value. 100% Stacked Column Charts can be thought of as a variation of a Bar Chart and are created in a similar fashion.
See Bar Charts for instructions on creating a 100% Stacked Column Chart. The example will result in the following:
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Pareto
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Pareto Charts are a special type of single series chart generally used to highlight the most important element amongst a group. The bars of a Pareto chart display in descending order while a line shows the cumulative percentage of the total. You can read more about Pareto Charts here.

In the following example, each bar represents the number of Orders per Customer, and the line represents the cumulative percentage of the total Orders.

NOTE. This report is making use of a Group Footer section to get a count of orders per customer. A Group Header may also be used. See Sections for more information.
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· Add a Report Footer section to the report. Select all the cells in the Report Footer and click the Merge Cells button ([image: image226.png]


).

· Select the merged cell and click the Insert Chart button ([image: image227.png]


).

· In the Appearance tab:

· Click on the Bar Chart menu and select the Pareto Chart option.

· Check the “Use 3D Style” box.

· Choose a size and color scheme.
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· In the Data tab:

· Set Data Values to the cell ‘=AggCount({Orders.OrderID})’. 

· Set Data Labels to the cell ‘Customers.CompanyName’.
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· In the Labels tab:

· Enter the text ‘Orders by Customer’ in the Chart Title.

· Enter the text ‘Customer’ in the X-Axis Title.

· Enter the text ‘Orders’ in the Y-Axis Title.
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· Click Finish and execute the report as HTML.

This is how the chart will appear in the report designer:
NOTE. The chart will appear as a template in the report designer. It will not populate the field data. 
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This is how the chart will appear in the final report:


NOTE. This example has a filter on Customers for brevity.
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Scatter

[image: image233.png]A#





A Scatter Chart uses coordinates to display values for two variables in a set of data. One variable is represented on the X-Axis, and another is represented on the Y-Axis. They are typically used to show correlations between variables for large sets of data.
In the following example, the data points on the chart are coordinate pairs of the total number of Orders per Customer, and the average Order price per Customer.
NOTE. This report is making use of a Group Footer section to get a count of orders per customer and an average order price per customer. A Group Header may also be used. See Sections for more information.
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· Add a Report Footer section to the report. Select all the cells in the Report Footer and click the Merge Cells button ([image: image235.png]


).

· Select the merged cell and click the Insert Chart button ([image: image236.png]


).

· In the Appearance tab:

· Click on the Scatter Chart menu and select the Scatter Chart option.

· Choose a size and color scheme.
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Complete the steps in the wizard below to create a chart
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· In the Data tab:

· Set Y Values to the cell ‘=Average({OrderDetails.UnitPrice})’.

· Set X Values to the cell ‘=AggCount({Orders.OrderID})’.
· Set Series Labels to ‘None’.
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· In the Labels tab:

· Enter the text ‘Price vs Num. Orders’ in the Chart Title.

· Enter the text ‘Number of Orders’ in the X-Axis Title.
· Enter the text ‘Average Price’ in the Y-Axis Title.

· Set the Legend Position to ‘None’
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· Click Finish and execute the report as HTML.

This is how the chart will appear in the report designer:
NOTE. The chart will appear as a template in the report designer. It will not populate the field data.

NOTE. The data rows are suppressed for clarity.
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This is how the chart will appear in the final report:
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Bubble

[image: image242.png]



A Bubble Chart uses bubbles of variable size as coordinates to display values for three variables in a set of data. One variable is represented on the X-Axis, another is represented on the Y-Axis, and a third is represented by the size of the bubble.

In the following example, the data bubbles are coordinate pairs of the total number of Orders per Customer, and the average Order price per Customer. The size of the bubbles is the average Discount per Customer.

NOTE. This report is making use of a Group Footer section to get a count of orders per customer, average order price per customer, and average discount per customer. A Group Header may also be used. See Sections for more information.
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· Add a Report Footer section to the report. Select all the cells in the Report Footer and click the Merge Cells button ([image: image244.png]


).

· Select the merged cell and click the Insert Chart button ([image: image245.png]


).

· In the Appearance tab:

· Click on the Scatter Chart menu and select the Bubble Chart option.

· Choose a size and color scheme.
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· In the Data tab:

· Set Y Values to the cell ‘=Average({OrderDetails.UnitPrice})’.

· Set X Values to the cell ‘=AggCount({Orders.OrderID})’.

· Set Series Labels to ‘Customers.CompanyName’.

· Set Bubble Sizes to ‘=Average({OrderDetails.Discount})’

· Set Bubble Labels to ‘None’.
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· In the Labels tab:

· Enter the text ‘Price vs Num. Orders’ in the Chart Title.

· Enter the text ‘Number of Orders’ in the X-Axis Title.

· Enter the text ‘Average Price’ in the Y-Axis Title.

· Set the Legend Position to ‘None’
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· Click Finish and execute the report as HTML.

This is how the chart will appear in the report designer:
NOTE. The chart will appear as a template in the report designer. It will not populate the field data.


NOTE. The data rows are suppressed for clarity.
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This is how the chart will appear in the final report:


NOTE. This example has a filter on Customers for brevity.
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Maps
A Map can be displayed in a report to give a visual representation of geographic data. To insert a Map, select a cell and click the Insert Map button ([image: image251.png]


). The Map Wizard will appear. The Map Wizard has three tabs: Type, Locations and Data.
NOTE. Maps should only be placed into a Group Header, Group Footer, Report Header or Report Footer section.
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Type 

In the Type tab select the initial view, size, colors, and where to display the legend.

· Use the Initial View drop-down to select the location that initially displays on the Map. You may either select the world, a continent, or a country.
· There are three ways to set the size of the Map.

· Enter the height and width in the dimension boxes.

· Resize the chart by dragging the lower right corner in the preview.

· Check the box ‘Fit to Cell’.

· In the Color drop-down either select a color theme or specify a linear range of colors.
· Check the ‘Show Legend’ box to display the legend.
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Locations

In the Locations tab specify which geographic locations should display on the Map.
· Use the Location Values drop-downs to select the cells that contain the geographic information for the Map. To utilize Region information, such as states/provinces, Country information must be provided. Similarly, City information requires Region and Country information.
· The ‘Show last Location type as’ drop-down specifies how to display the lowest level of information. You can either select circular markers (see image in Data tab) or shaded geographic regions (see image below).
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Data

In the Data tab specify which data determines the color of each country/region/city and the size of each marker.
For each Data Value:
· Use the Data Values drop-down to specify which cells on the report should be used to determine the color and the size of each marker. Setting a cell for the size of marker is optional.

· Enter a label in the Data Labels column. Labels will appear in the hover effects of Dynamic Maps.
· Use the Aggregation drop-down to select a method to perform on the data.

· Sum: Totals the Data Value for each location.
· Count: Counts all instances of the Data Value for each location.

· Distinct Count: Counts all unique instances of the Data Value for each location.
· Average: Takes the arithmetic mean of the Data Value for each location.
· Minimum: Displays the lowest value in the Data Value for each location.
· Maximum: Displays the highest value in the Data Value for each location.
· Use the Display Format drop-down to specify how to display the data.
· Default: Displays the values without any formatting.
· Currency: Prepends the currency symbol on the values.

· Percent: Multiplies the Data Value by 100 and appends a percent symbol (%) to the values.

· Scientific Notation: Displays the values in scientific notation.

· Ex. If Decimal Places are set to 2 then 123.45 would appear as 1.23 E2.
· For each Data Decimal Places: the number of decimal places to display.
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Example
Take the following report as an example. 
[image: image256.png]‘Section A

B c o E
1 Map Example
Page Header o
3 Companytiame Region Country city Orderid
Detai 4 Teustomers. Companyliame: Peustomers. Region "Customers Country "Customers.Cty  "Orders.OrderD




The subsequent steps show how to create a Map in this report. The Map will be colored based on the number of customers in each location and the markers will be sized based on how many orders have been placed in each location:

· Add a Report Footer section to the report, select all the cells in the Report Footer and click the merge cell button ([image: image257.png]


).

· Select the merged cell and click the Insert Map icon ([image: image258.png]


).

· In the Type tab:

· Set the initial view, size and color.
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· In the Locations tab, set the field Customers.Country for Country information, Customers.State for Region, and Customers.City for City information. Set the ‘Show last location type as’ drop-down to Markers.
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· In the Data tab:

· Set the field Customers.CompanyName for Color of Locations. Provide a label such as ‘Num. of Customers’ and set the Aggregate Type to Distinct Count.
· Set the field Orders.OrderId for the Size of Markers. Provide a label such as ‘Num. of Orders’ and set the Aggregate Type to Count.
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· Click Finish and execute the report as HTML.

Report Designer: 
NOTE. In the report designer the map is always represented by the same image regardless of the size, color or world view of the map that will be generated on the report.
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Map on HTML Export:
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Linked Reports
The ability to create drill downs can be added by linking reports. Linked reports are only available for HTML output.
· To link a report, select a cell and click the Linked Reports button ( [image: image264.png]


). The Linked Report window will appear displaying the available reports. Select the report you want to link and press ‘OK.’
· To unlink a report select the cell and open the Linked Report window. Click the ‘Remove Link’ button.
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When a link is set on a cell, the unique key of the information being displayed is used to automatically filter the linked report. In the example below the linked report is filtered for information where Category equals ‘Meat/Poultry’ because that was the Category clicked on.
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Chart Drilldowns

Chart drilldowns can also be created by using the Linked Reports menu. Chart drilldowns are only available for HTML output.
· To create a drilldown, select a cell that contains a chart and click the Linked Reports button ( [image: image267.png]


). The Linked Report window will appear displaying the available reports. Select the report you want to link and press ‘OK.’
· To remove a drilldown select the chart and open the Linked Report window. Click the ‘Remove Link’ button.
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Gauges
A Gauge can be displayed in a report to give a visual representation for the scale of a value. To insert a Gauge, select a cell and click the Insert Gauge button ([image: image269.png]


). The Gauge Wizard will appear. The Gauge Wizard has two tabs: Appearance and Data.
NOTE. Gauges can be placed in any section of the report.
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Appearance

In the Appearance tab select the Type and Dimension of the Gauge.
· Type – Select the icon representing the type of gauge. Available types include: Angular, Linear, Bulb and Thermometer.
· There are three ways to set the size of the Gauge.

· Enter the height and width in the dimension boxes.

· Resize the gauge by dragging the lower right corner in the preview.

· Check the box ‘Fit to Cell’.
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Data

In the Data tab select the Data Values and Color Ranges for the Gauge.
· Use the Data Values drop-down to select the cell that contains the numeric value for the Gauge.

· Use the ‘Provide range as’ buttons to specify if the Min and Max values for the Gauge should be static numbers or come from cells on the report.

· In the Color Ranges, use the ‘Color By’ buttons to specify if color ranges should be percentages of the Max value, static numbers, or come from cells on the report.
NOTE. Percent Color Ranges must be in ascending numeric order.

· Use the Add ([image: image272.png]& Add



) and Remove ([image: image273.png]


) buttons to create additional colors. 

NOTE. Thermometer Gauges can only have one color.

· To change a color either use the drop-down ([image: image274.png]


) or enter a Hex value.
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CrossTabs 

Crosstabs allow the report to expand both horizontally and vertically based on data values and displays summary information where each column and row meets. A CrossTab consists of three parts; Row Headers, Column Headers and Tabulation Data. Additional settings for CrossTabs can be found in the CrossTab Options Menu.
NOTE. For the section a CrossTab is in, all the cells below and to the right of a CrossTab must be empty.
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Row Headers
Row Headers expand a CrossTab vertically. A CrossTab has a row for each unique value of a Row Header. For example if you were using sales data you may have the Row Headers Category.CategoryName and Products.ProductName to provide rows for each product grouped by category (see image below).
· To add a Row Header either drag and drop it to the ‘Row Header Source’ panel or use the ‘Add Row Header’ button ([image: image277.png]


).
· Click the Formula Editor Button ([image: image278.png]h3



) to insert a formula into the Row Header.
· Click the Edit Header button ([image: image279.png]


) to open the Header Options Menu. In the Header Options Menu you can: 
· Set a Label for the Row Header. This label will appear at the top of the CrossTab.

· Select a Sorting Method and direction.

· None – Does not sort the Row Header.
· Header Value (Text) – Sorts the Row Header by its values as though they are text.

· Header Value (Number) – Sorts the Row Header by its values as though they are numbers.

· Tabular Totals – Sorts the Row Header by the totals of the Tabulation Data.

NOTE. If there is more than one Row Header the Header Options Menu for the top most Row Header will have Options for sub-totals of Tabulation Data.

· Select where to display subtotals by using the Placement dropdown.

· None – Does not display subtotals.

· Top – Displays subtotals above the Tabulation Data for each Row Header value.

· Bottom – Displays subtotals below the Tabulation Data for each Row Header value.

· Set a label for the subtotals.

· Use the up and down arrows to rearrange the order of the Row Headers.
· To remove a Row Header click the delete button ([image: image280.png]


).
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Column Headers
Column Headers expand a CrossTab horizontally. A CrossTab has a column for each unique value of a Column Header. For example if you were using sales data you may have the Column Headers ‘Year({Order.OrderDate})’ and ‘Month({Orders.OrderDate})’ to provide columns for each month grouped by year (Ex. see image below).
· To add a Column Header either drag and drop it to the ‘Column Header Source’ panel or use the ‘Add Column Header’ button ([image: image282.png]


).
· Click the Formula Editor Button ([image: image283.png]h3



) to insert a formula into the Column Header.
· Click the Edit Header button ([image: image284.png]


) to open the Header Options Menu. In the Header Options Menu you can: 
· Set a Label for the Column Header to appear at the top of the CrossTab.

· Select a Sorting Method and direction.

· None – Does not sort the Column Header.
· Header Value (Text) – Sorts the Column Header by its values as though they are text.

· Header Value (Number) – Sorts the Column Header by its values as though they are numbers.

· Tabular Totals – Sorts the Column Header by the totals of the Tabulation Data.

NOTE. If there is more than one Column Header the Header Options Menu for the top most Column Header will have Options for sub-totals of Tabulation Data.

· Select where to display subtotals by using the Placement dropdown.

· None – Does not display subtotals.

· Left – Displays subtotals to the left of the Tabulation Data for each Column Header value.

· Right – Displays subtotals to the right of the Tabulation Data for each Column Header value.

· Set a label for the subtotals.
· Use the up and down arrows to rearrange the order of the Column Headers.
· To remove a Column Header click the delete button ([image: image285.png]


).
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Tabulation Data

Tabulation Data provides information when data exists for the Column Header and Row Header values. For example if you have a Row Header on products and a Column Header on the month, then Tabulation Data of Orders.OrderID may use the Count function to display how many orders contained each product each month.
· To add a Tabulation Data either drag and drop it to the ‘Tabulation Data’ panel or use the ‘Add Tabulation Data’ button ([image: image287.png]


).
· Click the Formula Editor Button ([image: image288.png]h3



) to insert a formula into the Tabulation Data.
· Click the Edit Tabulation button ([image: image289.png]


) to open the Tabulation Options menu. In the Tabulation Options Menu you can: 

· Set a Label for the Tabulation Row to appear at the beginning of each row.

· Use the Method dropdown to select the summary function to be applied to the Tabulation Data.
· Sum: Totals the Tabulation Data.

· Count: Counts the Tabulation Data.

· Average: Take the arithmetic mean of the Tabulation Data.

· Minimum: Displays the lowest value in the Tabulation Data.

· Maximum: Displays the highest value in the Tabulation Data. 

· None: Displays the value of the Tabulation Data without applying any formula.

· Use the Value dropdown to select how the Tabulation Data should be displayed.

· Aggregate: Display the result of the selected Method.

· Percent of Row: Display the result of the selected method as a percentage of the row total.

· Percent of Colum: Display the result of the selected method as a percentage of the column total.

· Use the up and down arrows to move the Tabulation Data order.
· To remove a Tabulation Data click the delete button ([image: image290.png]


).
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CrossTab Themes

The Theme dropdown can be used to quickly style the CrossTab using one of the pre-defined themes. Further styling can be done to the cells of the CrossTab in the Report Designer.

CrossTab Options

Settings that affect the entire CrossTab are controlled in the CrossTab Options Menu. Open the CrossTab Options Menu by clicking the Options button ([image: image292.png]% Options



). Using this menu you can adjust the following settings:

General

· Use the Row Headers Placement dropdown to determine how the Row Headers are displayed.

· Columns – Display the Row Headers in columns from left to right in their order in the Row Header Source panel.

· Hierarchical – Display Row Headers in a hierarchical structure using indentation to display their order.
· Check ‘Repeat CrossTab Header every new page’ to repeat Row Header labels and Column Headers on each new page. 

Grand Total Row

· To get a total for each column, select ‘Top’ or ‘Bottom’ from the Placement dropdown in the Grand Total Row section and provide a label in the Label text box.
Grand Total Column

· To get a total for each row, select ‘Top’ or ‘Bottom’ from the Placement dropdown in the Grand Total Column section and provide a label in the Label text box.
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Renaming Reports

To change the name of a report click ‘Rename’ in the Toolbar drop-down menu. Enter a new name and select the folder you want to save the report. Click ‘OK’.
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Changing Description

The report description appears at the bottom of the Main Menu. Report descriptions are optional but they can be searched. To change a report description click ‘Description’ in the Toolbar drop-down menu. Write the description and click ‘OK.’
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Changing Data Categories

Before explaining how to make Data Categories accessible it is important to clarify two terms: Data Category and Data Field.
Data Category – A Data Category is an object that has a group of attributes. Ex. Orders is a category; each order has an ID, a date, a customer etc.
Data Field – A Data Field is a single attribute within a Data Category. Ex. Orders.OrderID is numeric value that identifies a specific order.
To modify the Data Categories click ‘Categories’ in the Toolbar drop-down menu.
· To add a Data Category to a report either drag and drop it to the ‘Category Name’ panel, use the ‘Add’ button or double-click it.
· To search for a specific Data Category type its name into the search box.
· To see what Data Fields are in a Category click the information button ([image: image298.png]


).
· Check the ‘Suppress Duplicates’ box to prevent duplicate information from appearing on the report.
· To remove a selected Category click the delete button ([image: image299.png]


).
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Changing Sorts
To modify the sort criteria of a report click ‘Sorts’ in the Toolbar drop-down menu.
· To sort by a Data Field either drag and drop it to the ‘Sort by’ panel, use the ‘Add’ button or double-click it.
· You can sort each field in ascending (A- Z) or descending (Z-A) order.
· Use the up and down arrows to indicate the sort priority.
· To remove a sort click the delete button ([image: image302.png]


).
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Changing Filters

To modify the filter criteria of a report click ‘Filters’ in the Toolbar drop-down menu. There are three types of filters: Standard, Interactive and Group. Standard filters are based on values you specify. Interactive filters can be applied after executing the report to HTML. Group filters are based on the minimum or maximum value in the Data Field.
Standard Filters

There is no limit to the number of filters that you can define. Filters can be numeric (up to eight decimals) or alphanumeric.
· To filter a Data Field either drag and drop it to the ‘Filter By’ panel, use the ‘Add’ button or double-click it.
· Use the up and down arrows to indicate the filter priority.\

· To remove a filter click the delete button ([image: image305.png]


).
· Set the operator (equal to, less than, one of, etc.) by selecting from the operator drop-down.
· To set the value on which to filter either enter it manually or select from the drop-down. If the Data Field is a date you may use the calendar or function buttons to select a value.
· To allow the filter to be modified at the time the report is executed check ‘Prompt for Value.’
· Use the And/Or drop-down to specify the relationship between filters. Choose AND to require that the selected filter and the one below it are both true. Choose OR to require that either be true.
· Check ‘Group With Next Filter’ to specify the precedence of the filters. Filters can be nested indefinitely by using the following keyboard shortcuts while a filter is selected:
· Ctrl + [ adds an open-parenthesis before the selected filter.
· Ctrl + ] adds a close-parenthesis after the selected filter.
· Ctrl + Shift + [ removes an open-parenthesis from before the selected filter.
· Ctrl + Shift + ] removes a close-parenthesis from after the selected filter. 
Interactive Filters

Interactive Filters can be created in the Interactive HTML Options Menu. These filters can be enabled, disabled or modified after executing the report to HTML. For more information see Interactive HTML Options.
Group (Min/Max) Filters

Group filters are based on the minimum or maximum value in the Data Field. To modify group filters click ‘Switch to Group(MIN/MAX) filters. There is no limit to the number of group filters you may define.
· To filter a Data Field’s minimum or maximum value either drag and drop it to the ‘Filter By’ panel, use the ‘Add’ button or double-click it.
· Specify Minimum or Maximum from the operator drop-down.
· Use the up and down arrows to indicate the filter priority.
· To remove a filter click the delete button ([image: image306.png]


).
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General Options
Hover over ‘Options’ in the Toolbar drop-down and then click on ‘General’ menu to open the Report Options Window. This window allows you to control various settings including default export type and page orientation.
General Options
· Use the Default Export Type drop-down to specify the default format for the report.
· From the ‘Include Setup’ menu select Top or Bottom to display the data categories, sorts and filters at either the beginning or end of the report.
· Output types may be disabled by unchecking the boxes for ‘Allowed Export Types’.
· Use the ‘Filter Execution Window’ drop-down to select which type of Filter menu displays when executing a report that have prompt for value filters.
· Default – Display the default type of filter execution window.
· Standard – Display the standard filter execution window.
· Simple with Operator – Display a simplified filter execution window that only allows the operator and value to be changed.
· Simple without Operator – Display a simplified filter window that only allows the filter value to be changed.
· Check ‘Always Show Filter Execution’ to show the filter menu and allow changes to be made each time the report is executed.
· Use the ‘No Data Qualify Display Mode’ to select what to display if no data qualifies for the report.
· Show Message – Display the standard no data qualified message.

· Show Report – Display the Page Header, Page Footer, Report Header and Report Footer sections of the report. Any cells containing Data Fields will not be displayed.
Excel Options
· Check ‘Suppress Formatting’ to prevent the report formatting from exporting to Excel.
Page Options

· Specify the size for the report in the ‘Page Size’ menu. Default is letter.
· Set the orientation for the report in the ‘Orientation’ menu. 
· Default is Portrait.Check ‘Fit to Page Width’ to scale all columns to fit the width of the page.
Specify the size for the report in the ‘Page Size’ menu. Default is letter.Set the orientation for the report in the ‘Orientation’ menu. Default is Portrait.Check ‘Fit to Page Width’ to scale all columns to fit the width of the page.
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Interactive HTML Options
Hover over ‘Options’ in the Toolbar drop-down and then click on ‘HTML’ menu to open the Interactive HTML Options Menu. This window allows you to control what interactive capabilities a user has when viewing HTML reports.
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General
· Uncheck ‘Show Grid’ to disable grid lines.
· Uncheck ‘Simulate PDF’ to have the report appear as though it is not on a page.
· Uncheck ‘Allow Hide/Show Columns on Execution’ to disable the Hide Columns tools.
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Filters

Interactive Filters are filters created on either Data Fields or Formulas and then enabled after executing a report to HTML.
· To filter a Data Field either drag and drop it to the ‘Filter’ panel, use the ‘Add’ button or double-click it. To filter by a formula first add a Data Field then use the formula button ([image: image314.png]h3



) to open the Formula Editor.
· In the Title box provide a name for the interactive filter.
· Use the Type dropdown to specify what kind of interactive filter to display:
· Single Choice: A dropdown with the possible values of the filter.
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· Multiple Choice: All possible values for the filter presented with check boxes to select a one or more values.
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· Single Slider: Select the filter value by sliding a point along a scale.
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· Range Slider:  A scale that displays values between two points.
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· Click the Format button ([image: image319.png]


) to open the format menu and specify how the filter values should be displayed.
· If filtering on an Aggregate formula such as AggSum() use the ‘Calculate Value Ever’ dropdown to select on which sorted field or category the aggregate should be applied.
· Use the ‘Value Sort Direction’ to specify if the filter values should display in ascending or descending order.
· Check the ‘Initially Display Filter on Panel’ box to have the filter enabled automatically when the report is executed to HTML.
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Sorts

Interactive sorts can be used to change the direction of a report’s Sorts while viewing the report as HTML.
· Uncheck ‘Display sorts on Execution’ to hide interactive sorts in the HTML Dock.
· In the Title column provide a name for each interactive sort.
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Advanced Options
Click ‘Advanced’ in the Toolbar drop-down menu to open the Advanced Options window. This window allows you to specify additional information about how the Data Categories relate to each other.
If a report has two or more Data Categories, then information will only appear if it matches both categories. Using the check boxes, specify information that you want displayed even if it only exists in one of the Data Categories.  For example if a report has two Data Categories, Orders and Customers, then only customers who have made orders will appear. By checking the appropriate box you can include information on customers that have not made orders.
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More Advanced Options
If you have been given permissions, additional options are available in the Advanced Menu. Before explaining how to use these options it is important to clarify the definition of a join.

Join – A join defines how two Data Categories are related. Each join has a ‘From’ Category and a ‘To’ Category. The From and To object must have one (or more) Data Fields that contain the same information.

Ex. A join exists between two Data Categories: Orders and Customers. The join goes ‘From’ Customers ‘To’ Orders. In this example, when a customer makes an order that customer’s ID is saved with the order. Thus, the Orders Category has the Data Field CustomerID. This Data Field matches the Data Field CustomerID in the Customers Category. This join assures that each customer is paired with the orders that they have made.

· To add a new join click the Add button ([image: image324.png]


).
· To edit a join click the edit button ([image: image325.png]


).
· Restore the default joins by clicking the Recreate button ([image: image326.png]C Recreate



).
· To remove a join click the delete button ([image: image327.png]


).
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When you click the Add or Edit buttons the Report Join Menu will appear. In this menu you can create or modify a Join for the report.
· To set the From Category select a Data Field from the Category and drag it into the ‘Join From’ panel or use the ‘Add From’ button ([image: image329.png]4 Add From



).
· To set the To Category select a Data Field from the Category and drag it into the ‘Join To’ panel or use the ‘Add To’ button ([image: image330.png]& AddTo



).
· Use the Up and Down Arrow buttons ([image: image331.png]


[image: image332.png]


) to reorder the Data Fields. The position of each Field in ‘Join From’ should match the position of its corresponding Field in ‘Join To’. Ex. In the image below Customers.CustomerID corresponds to Orders.CustomerID so both Fields are at the top of their sections.
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Document Template
Reports can also be used to fill in PDF, RTF or Excel templates such as internal or government documents. Click ‘Templates’ in the drop-down menu to open the ‘Document Template’ window.
· Before using the Templates window put your data into the cells of your report.
· From the top drop-down select the template you want to use.
· In the ‘Report Field’ column specify which cell of the report corresponds to each ‘Template Field’.
Once the fields are complete, executing the report in the same format as the template will produce a filled in template.
The example below shows the fields being set in the Document Template window and the output when the report is executed as a PDF.
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Duplicating Reports

Duplicating reports can save time. This feature creates a new report that is similar to an existing one. Instead of creating the new report from scratch, you can duplicate an existing report, rename it, and make your changes.

1. On the Main Menu, select the report you want to duplicate.
2. Click the Duplicate button. The Rename Report Window will open.
3. Type the name of the new report into the Report Name field.
4. Select the folder where the report will be saved.
5. Click OK.
Deleting Reports 

Deleting a report removes the report and all of its components.
To delete an existing report:

1. On the Main Menu, select the report you want to delete.
2. Click the Delete button ([image: image336.png]


). A dialog box will ask if you are sure you want to proceed.
3. Click OK on the dialog box. The report is deleted.
IMPORTANT. Once the report is deleted, there is no way to restore it.
Scheduling Reports 

Reports can be scheduled to be emailed. A scheduled report can be executed and emailed immediately or scheduled to be emailed on a recurring basis. The Scheduler Menu lets you schedule and email reports or edit existing schedules.

To open the Scheduler Menu:

1. In the Main Menu, select the report you want to schedule/email.
2. Click the Scheduler Menu button ([image: image337.png]


). The Schedule Menu will appear.
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a. To Schedule a report click new schedule button ([image: image339.png]


). The  Schedule Report Wizard will open in a new tab.
b. To email a report click email button ([image: image340.png]


). The Email Report Menu will appear.
c. To edit existing schedules click the edit schedule button ([image: image341.png]


). The Schedule Manager will open in a new tab.
NOTE. If you do not see a Schedule Report button in the Main Menu then you do not have Report Scheduler permissions and should contact your administrator. 

Schedule Report Wizard
The Schedule Report Wizard has four sub tabs. The Recurrence and Recipients tab are required, and the other tabs are optional.
1. Recurrence: Specify the name and format of the report and when the report should be sent out.
2. Parameters: (optional) Set values for any parameters used by the report.

3. Filters: (optional) Add filters to the report.
4. Recipients: Specify the recipient addresses, subject and body text of the email.
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Click Finish and the Scheduled Report will be saved and the tab will close.
Recurrence Tab
In the Recurrence Tab, give the schedule a name and format. Set the frequency you want the report to be executed and sent out. This recurrence can be a one time, a daily, a weekly, a monthly, or a yearly delivery. A date range can also be set to give the report delivery a defined start and end date.
· Give the Schedule a Name and select an export type from the drop-down.

· For PDF reports a password may be set. The password may require a minimum number of upper/lowercase letters or numbers. To find out the required password strength, hover the mouse over the Password box.
· To execute and send the report immediately, check the box ‘Execute Immediately’.

· Schedule Time

· Set the time of day the report should be executed by entering a time in the Schedule Time box.
· Check ‘Repeat every’ and then specify a time interval to have the schedule be sent on a recurring basis on the day(s) specified in as the Recurrence Pattern.

· Recurrence Patterns
· Once – Specify to execute the report on a specific day or immediately.
· Daily – Send the report every weekday or every set number of days.
· Weekly – Send the report on specific days of the week.
· Monthly – Set the day of the month to send the report.
· Yearly – Set the day of the year to send the report.
· Range of Recurrence 

· Use the Range of Recurrence section to set a start day and an end day for the report schedule.
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Parameters Tab

In the Parameters tab enter a value for each of the parameters listed.
NOTE. The Parameters Tab will only be visible if the report is utilizing parameters. See Parameters for more information.
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Filters Tab
In the Filters Tab create statements to filter the data at runtime. There are two types of filters: Standard and Group. Standard filters are based on values you specify. Group filters are based on the minimum or maximum value in the Data Field.
Standard Filters

There is no limit to the number of filters that you can define. Filters can be numeric (up to eight decimals) or alphanumeric.
· To filter a Data Field either drag and drop it to the ‘Filter By’ panel, use the ‘Add’ button or double-click it.
· Use the up and down arrows to indicate the filter priority.
· To remove a filter click the delete button ([image: image345.png]


).
· Set the operator (equal to, less than, one of, etc.) by selecting from the operator drop-down.
· To set the value on which to filter either enter it manually or select from the drop-down. If the Data Field is a date you may use the calendar or function buttons to select a value.
· To allow the filter to be modified at the time the report is executed check ‘Prompt for Value.’
· Use the And/Or drop-down to specify the relationship between filters. Choose AND to require that the selected filter and the one below it are both true. Choose OR to require that either be true.
· Check ‘Group With Next Filter’ to specify the precedence of the filters. Filters can be nested indefinitely by using the following keyboard shortcuts while a filter is selected:

· Ctrl + [ adds an open-parenthesis before the selected filter.
· Ctrl + ] adds a close-parenthesis after the selected filter.
· Ctrl + Shift + [ removes an open-parenthesis from before the selected filter.
· Ctrl + Shift + ] removes a close-parenthesis from after the selected filter. 
 
Group (Min/Max) Filters

Group filters are based on the minimum or maximum value in the Data Field. To modify group filters click ‘Switch to Group(MIN/MAX) filters’. There is no limit to the number of group filters you may define.
· To filter a Data Field’s minimum or maximum value either drag and drop it to the ‘Filter By’ panel, use the ‘Add’ button or double-click it. 
· Specify Minimum or Maximum from the operator drop-down.
· Use the up and down arrows to indicate the filter priority.
· To remove a filter click the delete button ([image: image346.png]


).
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Recipients Tab
In the Recipients Tab determine how the schedule will be delivered and list the email address(es) the report should be sent to. Email addresses should be separated by a semi-colon (;).
· Check ‘Email Results’ to have the report sent via email. Uncheck this option to have it saved to a repository.
· In the To field set the email address(es) that the report will be delivered to.
· In the Cc field set any address(es) to be carbon copied.
· In the Bcc field set any address(es) to be blind carbon copied.
· Set the subject of the email in the Subject field.
· In the Body field enter the text of the email to be sent with the report. To reference the report name use ‘@reportName@’.
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Email Report

In the Scheduler Menu use the icon ([image: image349.png]


) to email a report. An input field and execute button will appear.

· In the input field enter the email address.
· Click the drop-down arrow to change the format of the report.

· Click the execute button to run and email the report.
NOTE. You cannot email reports as HTML format.
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Manage Scheduled Reports
Scheduled Reports can be monitored, edited and removed using the Manage Scheduled Reports tab. To open the tab click the scheduler icon ([image: image351.png]


) in the Main Menu then click ([image: image352.png]


). The Manage Scheduled Reports tab will appear.
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· Click at the top of a column to sort the scheduled reports by that column.
· To update the status and list new schedules click the Refresh button.
· To removed completed schedules click the Flush button.
· Click the Edit icon ([image: image354.png]


) to open the Schedule Report Wizard and modify the report.
· To delete a schedule click the delete icon ([image: image355.png]


).
Executing Reports 

Reports can be executed from the Main Menu or the Report Design Tab.
In the Main Menu select the report you want to execute by clicking on it. With the report highlighted click the Execute Report button. To change the output format click the drop-down and select from the available formats (HTML, Excel, PDF, RTF, or CSV).
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In the Design Tab click the Execute Report button. To change the output format click the drop-down and select from the available formats (HTML, Excel, PDF, RTF, or CSV). See Report Options to change the default format for the report.
Interacting with HTML Reports
After executing a report to HTML you can make further modifications such as adjusting styles, resizing columns, applying filters, conditional formatting and more. These changes can be exported to other formats, saved to report or saved as a separate copy of the report.
For these interactions to be available they must be enabled in the Interactive HTML Options Menu in the report designer.
Changing Styling

While viewing an HTML report right click a cell to open the style menu. Using this menu you can change font, size, foreground and background color, bold, italic, underline and alignment options.
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Resizing Columns

The columns of an HTML report can be resized by dragging the light grey bar at the top of the page to the desired size.
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Applying Interactive Filters

Any available interactive filters can be enabled by clicking the plus button ([image: image360.png]


) in the Filters section of the HTML dock which is located next to the report.
NOTE. Interactive filters must be defined in the Interactive HTML Options Menu. Additional filters can be created directly on the HTML report by right clicking. See Conditional Filters for more details.
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After enabling a filter use the checkbox, dropdown or slider to select what values should appear on the report. After selecting a value the report will refresh with the filter applied.
Click the minus button ([image: image362.png]


) to remove an active filter. The report will refresh to deactivate the filter.
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Conditional Filters

While viewing an HTML report you can set filters on specific values in addition to the pre-defined interactive filters.
To create a conditional filter right click on a cell of the report, choose and operator from the ‘Apply To’ dropdown then click the filter button ([image: image364.png]


).
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The conditional filter will appear in the Dock below the interactive filters and sorts.
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Changing Sorts

In the dock next to the report you can change the direction of any sorts on the report by clicking the ascending ([image: image367.png]N



) and descending ([image: image368.png]N



) buttons.​​​​
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Additionally, you can sort by individual columns of the report by clicking on the light grey bar at the top of the page.
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Hiding Columns

In the dock next to the report you can show/hide the columns of the report by checking/unchecking the column names.
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Saving & Clearing Changes
Changes styling, column sizes, sorts and filters can be saved in a number of ways.

In the toolbar above the report:

· Using the Clear dropdown ([image: image372.png]


) you can remove any changes made to the report.
· Use the Save button ([image: image373.png]


) to save interactive changes onto the report.

· Use the Save as New Report button ([image: image374.png]


) to make a copy of the report with the changes.
· Use the Save Changes as User Report button ([image: image375.png]


) to save your changes as a User Report. The changes will be applied each time you execute the report but not when other users execute the report.
· Use the Delete User Report button ([image: image376.png]


) remove any changes that were saved as User Report.
Exporting to Other Formats

From the HTML viewer you can export a report, including any interactive changes, to other formats such as Excel, PDF, RTF, or CSV. To do so use the export button in the toolbar above the report and selected the export format.
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Creating and Editing Dashboards
Dashboards provide an HTML canvas that can display reports, data visualizations, images, text and web pages.
To create a new dashboard, click the New Dashboard icon in the Main Menu. The Dashboard Designer will appear in a new tab.
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Dashboard Designer

The Dashboard Designer can be used to add reports, text, images and web pages to a dashboard.
The Dashboard Designer has four components; the Design Canvas, Tool Box, Data Fields and the Toolbar.
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Dashboard Canvas

Within the Dashboard Designer you can:

· Move and resize Dashboard Items

· Style Dashboard Items with alignment, borders, colors, etc.
· Edit Dashboard Items such as Reports, Data Visualizations and Text
Toolbox
By dragging Dashboard Items from the Toolbox onto the canvas you can add the following:

· Reports

· Data Visualizations
· Text

· Images

· Web Pages
· Interactive Filters

Data Fields
After dragging a Data Visualization from the Toolbox on to the Canvas you can add Data Fields by dragging them over the Data Visualization.
Toolbar

Using the toolbar you are able to:

· Rename the Dashboard and modify its description.
· Set the Dashboard to automatically run when entering this tool.
· Change the background color of the canvas.
· Format the font, font size, alignment, color and borders of text.
· Save the dashboard.
· Execute the dashboard as HTML.
Dashboard Items
By dragging Dashboard Items onto the canvas you can add the following items to the dashboard:

· Reports

· Dashboard Visualizations

· Text

· Images

· Web Pages
· Interactive Filters

Adding Reports
To add an existing report to the dashboard drag and drop the Report Button ([image: image380.png]


) over the Dashboard Canvas. The Report Properties menu will appear. The Report Properties menu has four tabs: Report, Filters, Parameters and Options.

Report

In the Reports tab select the report you want to display on the dashboard.
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Filters

If the selected report has any Prompt for Value Filters, those filters will appear in the Filters tab. In this tab you can specify how to prompt for these filter values.

For each Filter:

· Use the Action dropdown to select how the filter should prompt.

· Dashboard Prompt – When the dashboard executes, you will be prompted for a value that is used by all of the reports on the dashboard that filter using this Data Field.
· Report Prompt – When the dashboard executes you will be prompted for a value to filter this specific report.

· Assign Value – Assign the filter a specific value. This filter will not prompt when the dashboard executes.
· In the ‘Data (Prompt Text or Value)’ column enter a value if the Action is Assign Value; if the Action is Dashboard or Report Prompt, enter text to use for the prompt.
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Parameters

If the selected report has any Prompting Parameters, those parameters will appear in the Parameters tab. In this tab you can specify how to prompt for these parameter values.

For each Parameter:

· Use the Action dropdown to select how the parameter should prompt.

· Dashboard Prompt – When the dashboard executes, you will be prompted for a value that is used by all of the reports on the dashboard that parameter.
· Report Prompt – When the dashboard executes you will be prompted for a value that is used by this specific report.

· Assign Value – Assign the parameter a specific value and do not prompt when the dashboard executes.
· In the ‘Data (Prompt Text or Value)’ column enter a value if the Action is Assign Value; if the Action is Dashboard or Report Prompt, enter text to use for the prompt.
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Options

In the Options tab specify settings for how the report displays on the dashboard.

Execute

· In the Title Text box, provide a title for the report. This title will be displayed in on the canvas when editing the dashboard.

· Check ‘Allow scrolling’ to allow scrolling on the dashboard if the report is larger than the designated size on the canvas.

· Set the number of seconds at which to re-execute the report. Set to 0 to only execute the report when the dashboard is first run.

Design

· Check the ‘Only execute report in design screen when report is manually refreshed’ to prevent the report from being executed while editing the dashboard.
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Adding Data Visualizations
To create a new Visualization on the dashboard drag and drop the Data Visualization icon ([image: image385.png]


) onto the Dashboard Canvas. A Data Visualization item will appear.
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With the Data Visualization item you can:

· Drag Data Fields onto the item to create a chart or a tabular report.

· Use the Options Menu ([image: image387.png]


) to filter, name or modify other settings of the Visualization.

· Modify how the Data Fields are grouped and summarized, by opening the Data Model Menu ([image: image388.png]


).
· Save the Data Visualization as a new Standard Report ([image: image389.png]


).

NOTE. Subsequent changes in the Standard Report Designer will not be reflected on the Data Visualization. To have those changes appear on the dashboard add the new report to the dashboard.

· Convert from a chart to tabular report (or vice versa) by selecting ‘Convert to Chart’ in the right-click menu.
NOTE. A Data Visualization must have at least two Data fields in order to display a chart, one of which must be numeric.

Adding Text

To add text to the dashboard drag and drop the Text icon ([image: image390.png]


) over the Dashboard Canvas. A text box will appear. Type the desired text in this box. Use the Toolbar  to format the text.
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Adding Images
To add an image to the dashboard drag and drop the Image icon ([image: image392.png]


) over the Dashboard Canvas. An image box will appear. Click the insert image button ([image: image393.png]


) and select the image to upload.
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Adding Web Pages

To add a web page to the dashboard drag the URL Button ([image: image395.png]


) over the Dashboard Canvas. A URL menu will appear. Entire the desired URL and press OK ([image: image396.png]


).
NOTE. Some web pages do not permit being embedded within another web page.

[image: image397.png][ New Dashboard Report *

= ) adial
e~ BZuUAbn

Toolbox

Data Fields

Northwind




Adding Interactive Filters
To add an interactive filter to the dashboard drag and drop the Filter icon ([image: image398.png]


) over the Dashboard Canvas. The Filter Properties menu will appear. The Filter Properties menu has two tabs: Reports and Filter.

Reports
In the Reports tab select which reports and data visualizations the filter should apply to by checking the box in the Controlled column.

NOTE. All of the reports and visualizations being controlled by the filter must share at least one common Data Category.
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Filter
In the Filter tab specify what data should be used and how the interactive filter should appear on the dashboard.
· Use the Filter value dropdown to select the data field that should be filtered.
NOTE. The filter can be applied to a calculation instead of a data field by using the formula button ([image: image400.png]h3



).

· Use the Type dropdown to specify what kind of interactive filter to display:
· Single Choice: A dropdown with the possible values of the filter.
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· Multiple Choice: All possible values for the filter presented with check boxes to select a one or more values.
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· Single Slider: Select the filter value by sliding a point along a scale.
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· Range Slider:  A scale that displays values between two points.
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· In the style dropdown specify if the filter should be vertically or horizontally oriented.
· In the Value Sort Direction specify if the filter values should appear from least to greatest (ascending) or vice versa (descending).
· Click the Format button ([image: image405.png]


) to open the format menu and specify how the filter values should be displayed.
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Toolbar

The toolbar contains the buttons and menus used to modify the dashboard.
Saving Dashboards

The dashboard can be saved by clicking the save button ([image: image407.png]


).
Undo/Redo

Any action on a dashboard can be undone by clicking ([image: image408.png]


) or pressing CTRL + Z. Undone actions can be redone by clicking ([image: image409.png]


) or pressing CTRL + Y.

Borders

To create borders around a dashboard item, select it and click the Format icon ([image: image410.png]


).
· Uncheck ‘Make Borders Uniform’ to modify specific edges.
· To widen the borders either key in a value or use the arrows in the width box.
· To change the color either select a color from the drop-down or enter a hex value.
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Borders can be rounded by clicking the ‘Rounded Edges’ button ([image: image412.png]


) in the toolbar.

Formatting Dashboard Text

Text items can be formatted using buttons in the toolbar. A text item must be selected for these changes to be applied.
Font

· To change the font use the font drop-down ([image: image413.png]


). The font names appear in the style that they represent.
· The B, I and U icons make the font bold, italicized and underlined, respectively.
· Text size can be controlled using the up and down arrows on font size menu ([image: image414.png]


).
Color

· To change the text color, click the Foreground Color button ([image: image415.png]


 ) and then select a color or enter a hex value into the Foreground box. Click the clear button to revert to the default color ([image: image416.png]


).
· To change the background color, click the Background Color button ([image: image417.png]


) and then select a color or enter a hex value into the Background box. Click the clear button to revert to the default color ([image: image418.png]


).
Alignment

· Text can be aligned to the top, center, or bottom of a cell using the vertical alignment buttons.
[image: image419.png]



· Text can be centered, justified or aligned to the left or right of a cell using the horizontal alignment buttons.
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Renaming Dashboards

To change the name of a dashboard click ‘Rename’ in the Toolbar drop-down menu. Modify the name and select the folder where the Dashboard will be saved. Click ‘OK’.
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Changing Description
The dashboard description appears at the bottom of the Main Menu. Though dashboard descriptions are optional they are utilized when searching reports. To modify a dashboard description click ‘Description’ in the Toolbar drop-down menu. Fill in the description and click ‘OK.’
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Dashboard Options

Click ‘Options’ in the Toolbar drop-down menu to open the Dashboard Options Window.
General Options
· To change the background color of the dashboard canvas, select a color or enter a hex value.

· Check ‘Show report title bar on execution’ to allow reports on an executed dashboard to be selected and modified.
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Executing Dashboards

Dashboards can be run from the Main Menu or the Toolbar. To run a dashboard from the Main Menu first select the dashboard you want to run and click the HTML button. When editing a dashboard simply click the HTML button to execute the dashboard.

NOTE. Dashboards can only be executed as HTML.
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Chained Reports

Chained Reports comprise multiple existing reports which are executed in a specific order and compiled into a single document. They are a simplified method for managing reports en masse.
NOTE. Chained Reports can only be executed as Excel, PDF, RTF, or CSV. HTML-only features are not supported in chained reports.
NOTE. Chained Reports do not support Excel templates. Additionally, all reports in a chained report must have a common RTF template (or lack thereof).

NOTE. The Scheduler does not support Chained Reports.
Chained Report Wizard

The Chained Report Wizard is an interactive tool which allows you to create and edit Chained Reports.

To navigate the wizard either click the desired tab or use the buttons at the bottom.

To save a Chained Report click the save button.
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The Chained Report Wizard has three sub tabs. The Name and Reports tabs must be completed.
Name Tab

In the Name tab enter a report name and click on the Folder where the report will be saved.

The report name can be up to 255 characters. Avoid special characters such as ? : / \ * “ < >.

The report’s description appears at the bottom of the Main Menu when it is selected. The description text is also used when searching for a report.

NOTE. You cannot create a report inside a folder that is read-only ([image: image430.png]


).
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Reports Tab
In the Reports tab select the reports you wish to include in the Chained Report.

NOTE. You can only include Standard Reports, Express Reports, and CrossTab reports in a Chained Report.
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· To add a report either drag and drop it to the ‘Report Name’ Column, use the ‘Add’ button or double-click it.
· To search for a specific report, enter the terms that you want to search for in the search box. To see all the reports click the Clear button ([image: image433.png]


).
· A report may be able to export only in certain formats. Available formats for each report are listed under Available Export Types. A Chained Report which contains a format restriction on one of its reports cannot execute in that format.
· If a report has Prompt for Value filters or parameters, click the ‘Edit Report Options’ button ([image: image434.png]


) to access the Report Properties menu, where you can specify how to prompt for these filter values:
· Common Prompt – When the Chained Report executes, you will be prompted for a value that is used by all of the reports on the Chained Report that have filter prompts on this Data Field.

· Report Prompt – When the Chained Report executes you will be prompted for a value to filter this specific report.

· Assign Value – Assign the filter a specific value. This filter will not prompt when the Chained Report executes.
· Use the up and down arrows to indicate the order of the reports.
· To remove a report click the delete button ([image: image435.png]


).

Options Tab

The Options tab allows you to control various report option settings for the chained report.
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General Export Options
· Use the ‘Default Export Type’ menu to specify the default format for the report.
· Output types may be disabled by unchecking the boxes for ‘Allowed Export Types’.
· Use the ‘No Data Qualified Action’ menu to select what to display if no data qualifies for a report.
· Skip Report – Display the next qualified report.

· Show Placeholder – Show a placeholder message in place of the report.
Formulas
Formulas allow you to do calculations, parse strings, insert images, and much more.  Formulas are the composition of functions, parameters, Data Fields and references to other cells.
Functions

Functions must begin with an ‘=’ sign. You can use more than one function in each cell. Additionally there are logical functions that allow for if/then/else conditional statements. Functions include date, financial, information, logical, mathematical, statistical, text and data.
NOTE. Function names are not case sensitive (aggSum is the same as AggSum).

For a complete list of functions, including description, remarks and examples, refer to Full Description of Functions.
Parameters

To call a parameter, enter its name between ‘@’ signs. Parameters can be used in functions or alone in a cell following an ‘=’ sign.

NOTE. Parameters are case sensitive (pageNumber is not the same as pagenumber). Parameter names should not contain the ‘@’ symbol.
For a list of parameters, including a description see Full Description of Parameters. Your administrator has the ability to create additional parameters.
Data Fields

To use a Data Field as part of a function enter the name between curly brackets (Ex.{Orders.OrdersID}).
Referencing a Cell
To reference another cell’s value enter the column name with a capital letter and the row number between square brackets (Ex. [A2]). A cell reference can be used in functions or alone in a cell following an ‘=’ sign.
NOTE. Cell references will update if rows or columns are added or deleted; however, dragging a cell will not update cell references. This may cause errors in your formulas.
Using Formulas
Formulas can either be entered in the Formula Editor or by manually written into cells.

Formula Editor
1. Navigate to the Report Designer.
2. Click in the cell you want the formula to be in.

3. Click the Formula Editor Button ([image: image437.png]h3



). 
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4. Create the desired formula by selecting the desired functions and clicking add or drag and 
        dropping into the Summary box.
NOTE. When embedding functions begin with the outermost function and add them moving inward. (ex. To get =TRUNCATE(SQRT(162)), first add Truncate then the square root function.)

5. Click OK.
Manual Formulas

To manually add formulas:

1. Navigate to the Report Designer.
2. Double click in the desired cell.
3. Enter the formula.
4. Save the report.
Full Description of Parameters

pageNumber:
	Description
	Returns the number of the current page.

	Remark
	For RTF output, pageNumber cannot be used with other formulas. 

	Example
	=@pageNumber@ will display the current page number for all output types.

=‘Pg. ‘ & @pageNumber@ will display ‘pg.’ followed by the page number for HTML and PDF output. 


reportName:
	Description
	Returns the name of the report.


reportFullName:
	Description
	Returns the file path of the report.

	Example
	For a report named Transcripts in a Folder named Student Documents @reportFullName@ would return Student Documents/Transcripts.


Quick List of Functions

Aggregate:

AggAvg


AggCount

AggDistinctCount

AggMax


AggMin


AggSum
Financial:

DB
DDB
Fv
Intrate
Ipmt
Nper
Npv
Pmt
Ppmt
Pv
Rate
Sln
Syd
Date:
Date
DateAdd
DateDiff
DateValue
Day
Days360
GlobalDateFormat
GlobalDateTimeFormat
Hour
Minute
Month
Now
Second
Time
TimeFormat1
TimeValue
Today
Year


Arithmetic & Geometric:
Absolute
Acos
Acosh
Asin
Asinh
Atan
Atan2
Atanh
Ceiling
Cos
Cosh
Even
Exp
Fixed
Floor
Int
Ln
Log
Log10
Mod
Odd
Pi
Power
Product
Quotient
Rand
Sin
Sinh
Sqrt
Tan
Tanh
Truncate

Formatting:
Bold

Italic

Underline 

String:

Concatenate
Left
Len
Lower
Mid
NewLine
Replace
Right
Trim
Upper
Value

Operators:

&
+

-

*
/

Logical:

And
False
If
Not
Or
Switch
True
Database & Data Type:

DBNull
IsBlank
IsError
IsEven
IsLogical
IsNonText
IsNull
IsNumber
IsOdd
IsText
Null
Type
Other: 

FilterValue
LoadImage
StripHTMLTag

Full Description of Functions

This section provides detailed information on the available functions.

Types of Functions:
· Aggregate Functions
· Logical Functions
· Date Functions
· Financial Functions
· Database and Data Type Functions
· Arithmetic and Geometric  Functions
· String Functions
· Formatting Functions
· Other Functions
Aggregate Functions

Aggregate functions can be executed on non-numeric fields.
AggAvg: 
	Description
	Returns the average of the values in the field.

	Remark
	Only accepts Data Fields as input.

	Example
	Ex. aggAvg({OrderDetail.Quantity}) - returns the average quantity of sales orders.


AggCount: 
	Description
	Returns the number of unique entities in the Data Category.

	Remark
	The aggCount function uses the Data Category, not the Data Field. For example, the function “aggCount( {Officer.Salary} )” counts the number of Officers. You could replace “Officer.Salary” with any other field in the Officer Data Category and the function would still count the number of officers.

Only accepts Data Fields as input.

	Example
	Ex. aggCount( {Orders.ProductPrice}) - returns the number of sales orders.


AggDistinctCount: 
	Description
	Returns the number of unique values in the Data Field.

	Remark
	Unlike aggCount, aggDistinctCount returns the number of unique values of the Data Field.

Only accepts Data Fields as input.

	Example
	Ex. aggDistinctCount({OrderDetail.Quantity}) - returns the number distinct quantities in an order. 


AggMax: 
	Description
	Returns the maximum value in the field.

	Remark
	Only accepts Data Fields as input.

	Example
	Ex. aggMax({OrderDetail.Discount}) - returns the largest discount.


AggMin: 
	Description
	Returns the minimum value in the field.

	Remark
	Only accepts Data Fields as input.

	Example
	Ex. aggMin({OrderDetail.Discount}) - returns the smallest discount.


AggSum: 
	Description
	Returns the sum of the values in the field.

	Remark
	Only accepts Data Fields as input.

	Example
	Ex. aggSum({OrderDetail.Quantity}) - returns the total quantity of units ordered.


Logical Functions

Logical functions can be used to handle conditional information.
And: 
	Description
	Returns TRUE if all its arguments are TRUE; returns FALSE if any argument is FALSE.

	Remark
	The arguments must evaluate to TRUE or FALSE. 
NOTE. The And function can take more than two arguments as input.

	Example
	Ex. AND(2+2=4, 4+0=4, 2+3=6) – returns FALSE.


False: 
	Description
	Returns the logical value FALSE.

	Remark
	You can also type the word FALSE directly onto the worksheet or into a formula; it is interpreted as the logical value FALSE.

	Example
	


If: 

	Description
	Takes three arguments as input. Returns the second argument if the first evaluates to TRUE. Otherwise returns the third argument.

	Remark
	The first input must evaluate to TRUE or FALSE.

	Example
	Ex. if({OrderDetail.Price}= 0,’FREE’,{OrderDetail.Price}) - returns FREE if the price is 0, otherwise it returns the price. 


Not: 
	Description
	Reverses the value of its argument.

	Remark
	Argument should evaluate to TRUE or FALSE.

	Example
	Ex. Not(FALSE) - returns TRUE.


Or: 

	Description
	Returns TRUE if any argument is TRUE.

	Remark
	The arguments must evaluate to logical values such as TRUE or FALSE.
NOTE. The ‘Or’ function can take more than two arguments as input.

	Example
	Ex. OR(2+2=4, 4+0=8, 2+3=6) - returns TRUE.


Switch: 

	Description
	This functions should be used instead of placing if() function inside of if() functions.

Takes any even number of inputs arguments.

	Remark
	The 1st argument will be the test value to compare to.
The 2nd argument will be returned if none of the comparisons return true.

The 3rd, 5th, 7th… arguments will be compared to the 1st argument. When the first match occurs the following argument will be returned. 

For example if argument 3 matches argument 1 then the 4th argument will be returned. 

	Example
	Ex. Switch({Categories.CategoryName},”NOT FOUND”, “Beverages”, “Drink up!”, “Condiments”, “Enhance”, “Confections”, “Sweet Tooth”) – returns a string based on the Category Name.


True: 

	Description
	Returns the logical value TRUE.

	Remark
	You can also type the word TRUE directly onto the worksheet or into a formula; it is interpreted as the logical value TRUE.

	Example
	


Date Functions 
Date functions can be used to do calculations and formatting on Date values. 
Date: 
	Description
	Creates a date value from three numeric values.

	Remark
	This function should be used to represent a date to other functions instead of representing a date as text.

	Example
	Ex. Date(2012,7,4) – returns the date July 4th , 2012.


DateAdd: 
	Description
	Returns the sum of a date and a quantity of time.

	Remark
	DateAdd takes three input arguments. 

A string representing the interval you want to add. The interval can be. "yyyy" (year), "y" (days), "d" (days), "w" (weeks), "m" (months), "h" (hours), "n" (minutes), "s" (seconds), "ww" (weeks of year), or "q" (quarters). 

A real number representing how much time you want to add to the date. 

A DateValue.


	Example
	Ex. DateAdd(‘h’,1,Now()) – returns the date and time 1 hour from now.


DateDiff: 

	Description
	Returns the amount of time between two dates. 

	Remark
	DateDiff takes three input arguments. 

A string representing the interval you want to add. The interval can be. "yyyy" (year), "y" (days), "d" (days), "w" (weeks), "m" (months), "h" (hours), "n" (minutes), "s" (seconds), "ww" (weeks of year), or "q" (quarters). 

The first date value.

The second date value.

	Example
	Ex. DateDiff(“yyyy”, date(1787,9,17), now())- returns the number of years since the signing of the United States’ Constitution


DateValue: 

	Description
	Converts a date represented as text (e.g. '30-jan-2008') to a date value. 

	Remark
	Any time information in the Date_text is ignored. The ticks returned always represent a time-of-day of Midnight (in the server's local time).

If the year portion of Date_text is omitted, DATEVALUE uses the current year on the server.
Use this function when comparing two dates.

	Example
	Ex. DateValue(30-jun-2011) – returns the date object 6/30/2011.

Ex. DateValue({Orders.OrderDate}) > DateValue(Today()) – compares the order date to today.


Day: 

	Description
	Returns the day portion of a date as a whole number.

	Remark
	Values returned by the YEAR, MONTH and DAY functions will be Gregorian Calendar values regardless of the display format for the supplied date value.

	Example
	Ex. Day({Appointment.Date}) - returns the day of the appointment.


Day360: 

	Description
	Returns the number of days between two dates based on a 360-day year. 

	Remark
	Often used in accounting applications.
Date360 takes three input arguments. 

The first date value.

The second date value.

Optional: True/False indicating to use European or American method of computation. If not included the American method is used.

	Example
	Ex. Day360({Appointment.Date},today())- returns the number of days between today and the appointment date.


GlobalDateFormat: 

	Description
	Returns a DATE value whose format is based on the session format.

	Remark
	Only accepts data objects as input.

	Example
	Ex. GlobalDateFormat({Appointment.Date})- returns the date of the appointment based on the session format.


GlobalDateTimeFormat: 

	Description
	Returns a DATETIME value whose format is based on the session format.

	Remark
	Only accepts data objects as input.

	Example
	Ex. GlobalDateTimeFormat({Appointment.Date})- returns the date and time of the appointment based on the session format.


Hour: 

	Description
	Returns the hour of a time value ranging from 0 (12:00 AM) to 23 (11:00 PM). 

	Remark
	Times may be entered as text strings within quotation marks or a date time value.

	Example
	Ex.  Hour("2:50:05PM") – returns 14.


Minute: 

	Description
	Returns the Minute of a time value ranging from 0 to 59. 

	Remark
	Times may be entered as text strings within quotation marks or a date time value.

	Example
	Ex.  Minute("2:50:05PM") – returns 50.


Month: 

	Description
	Returns the month portion of a date as a whole number, ranging from 1 (January) to 12 (December).

	Remark
	Values returned by the YEAR, MONTH and DAY functions will be Gregorian Calendar values regardless of the display format for the supplied date value.

	Example
	Ex. Month({Appointment.Date})- returns the month of the appointment.


Now: 

	Description
	Returns today’s date and time (in local server time).

	Remark
	If embedding in other functions use Now(‘false’).

	Example
	Ex. Now() - returns the current date and time. 
Now(‘false’) returns the current date and time formatted MM/dd/yyyy hh:mm:ss.


Second: 

	Description
	Returns the seconds of a time value ranging from 0 to 59. 

	Remark
	When a time omits seconds, 0 (zero) is assumed.

Times may be entered as text strings within quotation marks or a date time value.

	Example
	Ex.  Second("2:50:05PM") – returns 5.


Time: 

	Description
	Returns the number of ticks in a period of hours, minutes and seconds.

	Remark
	This function should be used to represent a time to other functions instead of representing a time as text.
Time takes three input arguments. 

Hours

Minutes

Seconds

	Example
	Ex.  Time(14,50,5) – returns 534050000000.


TimeFormat1: 

	Description
	Returns the time component of a DATETIME input formatted as 'hh:mm tt'.

	Remark
	This function should be used to represent a time to other functions instead of representing a time as text.

	Example
	Ex.  Timeformat1({Appointment.Date}) – returns the appointment date in the format as ‘hh:mm tt’.


TimeValue: 

	Description
	Convert a time represented in text (i.e., “HH-mm-ss”) into time values that can be passed to other functions.

	Remark
	Acceptable formats include "5:55 PM" and "17:55". A time separator is mandatory ("17:00" is acceptable, "1700" is not).

If AM/PM is not present AM is assumed. When specifying AM or PM, do not use periods ("A.M." or "P.M." will return an error).

	Example
	Ex. TimeValue(Time(14,50,5))- returns the time object 14:50:05.


Today: 

	Description
	Returns today’s date with no time component.

	Remark
	If embedding in other functions use Today(‘false’).

See the Now() function to get today's date with its time component.

	Example
	Ex. Today()- returns the current date.

Today(‘false’) returns the current date formatted as MM/dd/yyyy.


Year: 

	Description
	Returns the year portion of a date as a whole number, ranging from 1 to 9999.

	Example
	Ex.  Year(today()) – returns 2011.


 

 

Financial Functions

DB: 

	Description
	Returns the depreciation of an asset for a specified period using the fixed-declining balance method. Cost is the initial cost of the asset. Salvage is the value at the end of the depreciation (sometimes called the salvage value of the asset). Life is the number of periods over which the asset is being depreciated (sometimes called the useful life of the asset). Period is the period for which you want to calculate the depreciation. Period must use the same units as life. Month is the number of months in the first year. If month is omitted, it is assumed to be 12.

	Remark
	The fixed-declining balance method computes depreciation at a fixed rate. DB uses the following formulas to calculate depreciation for a period: (cost - total depreciation from prior periods) * rate where: rate = 1 - ((salvage / cost) ^ (1 / life)), rounded to three decimal places. Depreciation for the first and last periods is a special case. For the first period, DB uses this formula: cost * rate * month / 12. For the last period, DB uses this formula: ((cost - total depreciation from prior periods) * rate * (12 - month)) / 12.

	Example
	Data Assumptions: Initial cost=1,000,000 (A2); Salvage value=100,000 (A3); Lifetime in years=6 (A4). 

Ex. DB([A2],[A3],[A4],1,7) - Depreciation in first year, with only 7 months calculated (186,083.33). 
Ex. DB([A2],[A3],[A4],2,7) - Depreciation in second year (259,639.42). 
Ex. DB([A2],[A3],[A4],3,7) - Depreciation in third year (176,814.44).
Ex. DB([A2],[A3],[A4],4,7) - Depreciation in fourth year (120,410.64). 
Ex. DB([A2],[A3],[A4],5,7) - Depreciation in fifth year (81,999.64). 
Ex. DB([A2],[A3],[A4],6,7) - Depreciation in sixth year (55,841.76). 
Ex. DB([A2],[A3],[A4],7,7) - Depreciation in seventh year, with only 5 months 
calculated (15,845.10).


 DDB: 

	Description
	Returns the depreciation of an asset for a specified period using the double-declining balance method or some other method you specify. Cost is the initial cost of the asset. Salvage is the value at the end of the depreciation (sometimes called the salvage value of the asset). Life is the number of periods over which the asset is being depreciated (sometimes called the useful life of the asset). Period is the period for which you want to calculate the depreciation. Period must use the same units as life. Factor is the rate at which the balance declines. If factor is omitted, it is assumed to be 2 (the double-declining balance method). 
NOTE. All five arguments must be positive numbers.

	Remark
	The double-declining balance method computes depreciation at an accelerated rate. Depreciation is highest in the first period and decreases in successive periods. DDB uses the following formula to calculate depreciation for a period: ((cost-salvage) - total depreciation from prior periods) * (factor/life). Change factor if you do not want to use the double-declining balance method. Use the VDB function if you want to switch to the straight-line depreciation method when depreciation is greater than the declining balance calculation.

	Example
	Data Assumptions: Initial cost=2400 (A2); Salvage value=300 (A3); Lifetime in years=10 (A4). 
Ex. DDB([A2],[A3],[A4]*365,1)  - First day's depreciation. 
Ex. DDB([A2],[A3],[A4]*12,1,2) - First month's depreciation (40.00). 
Ex. DDB([A2],[A3],[A4],1,2) - First year's depreciation (480.00). 
Ex. DDB([A2],[A3],[A4],10) - Tenth year's depreciation. 
NOTE. that the results are rounded to two decimal places.


FV: 

	Description
	Returns the future value of an investment based on periodic, constant payments and a constant interest rate.

	Remark
	For a more complete description of the arguments in FV and for more information on annuity functions, see PV (Above). Rate is the interest rate per period. Nper is the total number of payment periods in an annuity. Pmt is the payment made each period; it cannot change over the life of the annuity. Typically, pmt contains principal and interest but no other fees or taxes. If pmt is omitted, you must include the pv argument. Pv is the present value, or the lump-sum amount that a series of future payments is worth right now. If pv is omitted, it is assumed to be 0 (zero), and you must include the pmt argument. Type is the number 0 or 1 and indicates when payments are due. If type is omitted, then it is assumed to be 0. Make sure that you are consistent about the units you use for specifying rate and nper. If you make monthly payments on a four-year loan at 12 percent annual interest, use 12%/12 for rate and 4*12 for nper. If you make annual payments on the same loan, use 12% for rate and 4 for nper. For all the arguments, cash you pay out, such as deposits to savings, is represented by negative numbers; cash you receive, such as dividend checks, is represented by positive numbers.

	Example
	Data Assumptions: Annual interest rate=6% (A2); Number of payments=10 (A3); Amount of the payment=-200 (A4); Present value=-500 (A5); Payment is due at the beginning of the period=1 (A6)...(see above). 

Ex. FV([A2]/12, [A3], [A4], [A5], [A6]) – returns future value of an investment with these terms (2,581.40).


 Intrate: 

	Description
	Returns the interest rate for a fully invested security. 
NOTE.  Dates should be entered by using the DATE function, or as results of other formulas or functions. 
For example, use DATE(2008,5,23) for the 23rd day of May, 2008. Problems can occur if dates are entered as text. Settlement is the security's settlement date. The security settlement date is the date after the issue date when the security is traded to the buyer. Maturity is the security's maturity date. The maturity date is the date when the security expires. Investment is the amount invested in the security. Redemption is the amount to be received at maturity. Basis is the type of day count basis to use.

	Remark
	The settlement date is the date a buyer purchases a coupon, such as a bond. The maturity date is the date when a coupon expires. For example, suppose a 30-year bond is issued on January 1, 2008, and is purchased by a buyer six months later. The issue date would be January 1, 2008, the settlement date would be July 1, 2008, and the maturity date would be January 1, 2038, which is 30 years after the January 1, 2008, issue date. Settlement, maturity, and basis are truncated to integers. If settlement or maturity is not a valid date, INTRATE returns the #VALUE! error value. If investment = 0 or if redemption = 0, INTRATE returns the #NUM! error value. If basis < 0 or if basis > 4, INTRATE returns the #NUM! error value. If settlement = maturity, INTRATE returns the #NUM! error value.

	Example
	Data Assumptions...Settlement date=February 15, 2008 (A2); Maturity date=May 15, 2008 (A3); Investment=1,000,000 (A4); Redemption value=1,014,420 (A5); Actual/360 basis (see above)=2 (A6). 

Ex. INTRATE([A2],[A3],[A4],[A5],[A6])  - returns discount rate, for the terms of the bond above (0.05768 or 5.77%).


Ipmt: 
	Description
	Returns the interest payment for a given period for an investment based on periodic, constant payments and a constant interest rate. For a more complete description of the arguments in IPMT and for more information about annuity functions, see PV. Rate is the interest rate per period. Per is the period for which you want to find the interest and must be in the range 1 to nper. Nper is the total number of payment periods in an annuity. Pv is the present value, or the lump-sum amount that a series of future payments is worth right now. Fv is the future value, or a cash balance you want to attain after the last payment is made. If fv is omitted, it is assumed to be 0 (the future value of a loan, for example, is 0). Type is the number 0 or 1 and indicates when payments are due. If type is omitted, it is assumed to be 0.

	Remark
	Make sure that you are consistent about the units you use for specifying rate and nper. If you make monthly payments on a four-year loan at 12 percent annual interest, use 12%/12 for rate and 4*12 for nper. If you make annual payments on the same loan, use 12% for rate and 4 for nper. For all the arguments, cash you pay out, such as deposits to savings, is represented by negative numbers; cash you receive, such as dividend checks, is represented by positive numbers.

	Example
	Data Assumptions: Annual interest=10% (A2); Period for which you want to find the interest=1 (A3); Years of loan=3 (A5); Present value of loan=8000 (A6). 

Ex. IPMT([A2]/12, [A3]*3, [A4], [A5]) - Interest due in the first month for a loan with the terms above (-22.41). 

NOTE. The interest rate is divided by 12 to get a monthly rate. The years the money is paid out is multiplied by 12 to get the number of payments.


Nper: 

	Description
	Returns the number of periods for an investment based on periodic, constant payments and a constant interest rate. For a more complete description of the arguments in NPER and for more information about annuity functions, see PV (above). Rate is the interest rate per period. Pmt is the payment made each period; it cannot change over the life of the annuity. Typically, pmt contains principal and interest but no other fees or taxes. Pv is the present value, or the lump-sum amount that a series of future payments is worth right now. Fv is the future value, or a cash balance you want to attain after the last payment is made. If fv is omitted, it is assumed to be 0 (the future value of a loan, for example, is 0). Type is the number 0 or 1 and indicates when payments are due.

	Remark
	Set Type equal to 0 (or omitted) if payments are due at the end of the period; Set type equal to 1 if payments are due at the beginning of the period.

	Example
	Data Assumptions: Annual interest rate=12% (A2); Payment made each period=-100 (A3); Present Value=-1000 (A4); Future Value=10000 (A5); Payment is due at the beginning of the period=1 (A6). 

Ex. NPER([A2]/12, [A3], [A4], [A5], 1) - Periods for the investment with the above terms (60). 
Ex. NPER([A2]/12, [A3], [A4], [A5]) - Periods for the investment with the above terms, except payments are made at the beginning of the period (60). 
Ex. NPER([A2]/12, [A3], [A4]) - Periods for the investment with the above terms, except with a future value of 0 (-9.578).


Npv: 

	Description
	Calculates the net present value of an investment by using a discount rate and a series of future payments (negative values) and income (positive values). Rate is the rate of discount over the length of one period. Value1, value2, ...are 1 to 29 arguments representing the payments and income. Value1, value2, ...must be equally spaced in time and occur at the end of each period. NPV uses the order of value1, value2, ...to interpret the order of cash flows. Be sure to enter your payment and income values in the correct sequence. Arguments that are numbers, empty cells, logical values, or text representations of numbers are counted; arguments that are error values or text that cannot be translated into numbers are ignored. If an argument is an array or reference, then only numbers in that array or reference are counted. Empty cells, logical values, text, or error values in the array or reference are ignored.

	Remark
	The NPV investment begins one period before the date of the value1 cash flow and ends with the last cash flow in the list. The NPV calculation is based on future cash flows. If your first cash flow occurs at the beginning of the first period, the first value must be added to the NPV result, not included in the values arguments. For more information, see the example below. NPV is similar to the PV function (present value). The primary difference between PV and NPV is that PV allows cash flows to begin either at the end or at the beginning of the period. Unlike the variable NPV cash flow values, PV cash flows must be constant throughout the investment. For information about annuities and financial functions, see PV. NPV is also related to the IRR function (internal rate of return). IRR is the rate for which NPV equals zero: NPV(IRR(...), ...) = 0.

	Example
	Data Assumptions: Annual discount rate=10% (A2); Initial cost of investment one year from today=-10,000 (A3); Return from first year=3,000 (A5); Return from second year=4,200 (A6).

Ex. NPV([A2], [A3], [A4], [A5], [A6]) - Net present value of this investment (1,188.44) ...In the preceding example, you include the initial $10,000 cost as one of the values, because the payment occurs at the end of the first period.


Pmt: 

	Description
	Calculates the payment for a loan based on constant payments and a constant interest rate. For a more complete description of the arguments in PMT, see the PV function. Rate is the interest rate for the loan. Nper is the total number of payments for the loan. Pv is the present value, or the total amount that a series of future payments is worth now; also known as the principal. Fv is the future value, or a cash balance you want to attain after the last payment is made. If fv is omitted, it is assumed to be 0 (zero), that is, the future value of a loan is 0. Type is the number 0 (zero) or 1 and indicates when payments are due.

	Remark
	The payment returned by PMT includes principal and interest but no taxes, reserve payments, or fees sometimes associated with loans. Make sure that you are consistent about the units you use for specifying rate and nper. If you make monthly payments on a four-year loan at an annual interest rate of 12 percent, use 12%/12 for rate and 4*12 for nper. If you make annual payments on the same loan, use 12 percent for rate and 4 for nper.

	Example
	Data Assumptions: Annual interest rate=8% (A2); Number of months of payments=10 (A3); Amount of loan=10000 (A4).
Ex. PMT([A2]/12, [A3], [A4]) - Monthly payment for a loan with the above terms (-1,037.03).
Ex. PMT([A2]/12, [A3], [A4], 0, 1) - Monthly payment for a loan with the above terms, except payments are due at the beginning of the period (-1,030.16).


Ppmt: 

	Description
	Returns the payment on the principal for a given period for an investment based on periodic, constant payments and a constant interest rate. For a more complete description of the arguments in PPMT, see PV (above). Rate is the interest rate per period. Per specifies the period and must be in the range 1 to nper. Nper is the total number of payment periods in an annuity. Pv is the present value—the total amount that a series of future payments is worth now. Fv is the future value, or a cash balance you want to attain after the last payment is made. If fv is omitted, it is assumed to be 0 (zero), that is, the future value of a loan is 0. Type is the number 0 or 1 and indicates when payments are due.

	Remark
	Make sure that you are consistent about the units you use for specifying rate and nper. If you make monthly payments on a four-year loan at 12 percent annual interest, use 12%/12 for rate and 4*12 for nper. If you make annual payments on the same loan, use 12% for rate and 4 for nper.

	Example
	Data Assumptions: Annual interest rate=10% (A2); Number of years in the loan=2 (A3); Amount of loan=2000 (A4).
Ex. PPMT([A2]/12, 1, [A3]*12, [A4]) - Payment on principle for the first month of loan (-75.62). 

NOTE. the interest rate is divided by 12 to get a monthly rate. The number of years the money is paid out is multiplied by 12 to get the number of payments.


Pv: 

	Description
	Returns the present value of an investment. The present value is the total amount that a series of future payments is worth now. For example, when you borrow money, the loan amount is the present value to the lender. Rate is the interest rate per period. For example, if you obtain a car loan at a 10% annual interest rate and make monthly payments, your interest rate per month is 10%/12, or 0.83%. You would enter 10%/12, or 0.83%, or 0.0083, into the formula as the rate. Nper is the total number of payment periods in an annuity. For example, if you get a four-year car loan and make monthly payments, your loan has 4*12 (or 48) periods. You would enter 48 into the formula for nper. Pmt is the payment made each period and cannot change over the life of the annuity. Typically, pmt includes principal and interest, but no other fees or taxes. For example, the monthly payments on a $10,000, four-year car loan at 12 percent are $263.33. You would enter -263.33 into the formula as the pmt. If pmt is omitted, you must include the fv argument. Fv is the future value, or a cash balance you want to attain after the last payment is made. If fv is omitted, then it is assumed to be 0 (the future value of a loan, for example, is 0). For example, if you want to save $50,000 to pay for a special project in 18 years, then $50,000 is the future value. You could then make a conservative guess at an interest rate and determine how much you must save each month. If fv is omitted, then you must include the pmt argument. Type is the number 0 or 1 and indicates when payments are due.

	Remark
	Make sure that you are consistent about the units you use for specifying rate and nper. If you make monthly payments on a four-year loan at 12 percent annual interest, use 12%/12 for rate and 4*12 for nper. If you make annual payments on the same loan, use 12% for rate and 4 for nper. In annuity functions, cash you pay out, such as a deposit to savings, is represented by a negative number; cash you receive, such as a dividend check, is represented by a positive number. For example, a $1,000 deposit to the bank would be represented by the argument -1000 if you are the depositor and by the argument 1000 if you are the bank.

	Example
	Data Assumptions: Money paid out of an insurance annuity at the end of every month=500 (A2); 8% is the interest rate earned on the money paid out (A3); 20 is the number of years the money will be paid out (A4).
Ex. Pv([A3]/12, 12*[A4], [A2], , 0) - Present value of an annuity with the stated terms (-59,777.15). The result is negative because it represents money that you would pay in an outgoing cash flow. If you are asked to pay ($60,000) for the annuity, you would determine this would not be a good investment because the present value of the annuity (59,777.15) is less than what you are asked to pay. 
NOTE. that the interest rate is divided by 12 to get a monthly rate. The years the money is paid out is multiplied by 12 to get the number of payments.


Rate: 

	Description
	Returns the interest rate per period of an annuity. RATE is calculated by iteration and can have zero or more solutions. If the successive results of RATE do not converge to within 0.0000001 after 20 iterations, RATE returns the #NUM! error value. For a complete description of the arguments nper, pmt, pv, fv, and type, see PV. Nper is the total number of payment periods in an annuity. Pmt is the payment made each period and cannot change over the life of the annuity. Typically, pmt includes principal and interest but no other fees or taxes. If pmt is omitted, you must include the fv argument. Pv is the present value—the total amount that a series of future payments is worth now. Fv is the future value, or a cash balance you want to attain after the last payment is made. If fv is omitted, it is assumed to be 0 (the future value of a loan, for example, is 0). Type is the number 0 or 1 and indicates when payments are due.

	Remark
	Guess is your guess for what the rate will be. If you omit guess, it is assumed to be 10 percent. If RATE does not converge, try different values for guess. RATE usually converges if guess is between 0 and 1. Make sure that you are consistent about the units you use for specifying guess and nper. If you make monthly payments on a four-year loan at 12 percent annual interest, use 12%/12 for guess and 4*12 for nper. If you make annual payments on the same loan, use 12% for guess and 4 for nper.

	Example
	Data Assumptions: Years of the loan=4 (A2); Monthly payment=-200 (A3); Amount of the loan=8000 (A4).
Ex. Rate([A2]*12, [A3], [A4]) - Monthly rate of the loan with the stated terms (1%).
NOTE. that the number of years of the loan is multiplied by 12 to get the number of months.


Sln: 

	Description
	Returns the straight-line depreciation of an asset for one period.

	Remark
	Cost is the initial cost of the asset. Salvage is the value at the end of the depreciation (sometimes called the salvage value of the asset). Life is the number of periods over which the asset is depreciated (sometimes called the useful life of the asset).

	Example
	Data Assumptions: Cost=30,000 (A2); Salvage value=7,500 (A3); Years of useful life=10 (A4).
Ex. Sln([A2], [A3], [A4]) - The depreciation allowance for each year (2,250).


Syd: 

	Description
	Returns the sum-of-years' digits depreciation of an asset for a specified period.

	Remark
	Cost is the initial cost of the asset. Salvage is the value at the end of the depreciation (sometimes called the salvage value of the asset). Life is the number of periods over which the asset is depreciated (sometimes called the useful life of the asset). Per is the period and must use the same units as life.

	Example
	Data Assumptions: initial cost=30,000 (A2); Salvage value=7,500 (A3); Lifespan in years=10 (A4).
Ex. Syd([A2], [A3], [A4], 1) - Yearly depreciation allowance for the first year (4,090.91).
Ex. Syd([A2], [A3], [A4], 10) - Yearly depreciation allowance for the tenth year (409.09).


Database & Data Type Functions

DataRowCount: 


	Description
	Returns the number of rows retrieved from the data source when executing the report.

	Example
	Suppose report is run to retrieve basic information on 10 employees

Ex. DataRowCount() should return 10.


DBNull: 

	Description
	Returns DBNULL.


IsBlank: 

	Description
	Checks if a cell is empty.

	Example
	Ex. IsBlank([A1]) – returns TRUE if the cell [A1] is blank, FALSE otherwise.


IsError: 

	Description
	Checks if a value is an error value.

	Remark
	Error values include (#N/A, #VALUE!, #REF!, #DIV/0!, #NUM!, #NAME?, or #NULL!).

	Example
	Ex. IsError([A1]) – returns TRUE if the cell [A1] contains an error value, FALSE otherwise.


IsEven: 

	Description
	Checks if a value is an even number.

	Example
	Ex. IsEven([A1]) – returns TRUE if the cell [A1] contains an even number, FALSE otherwise.


IsLogical: 

	Description
	Checks if a value is TRUE or FALSE.

	Example
	Ex. IsLogical([A1]) – returns TRUE if the cell [A1] contains TRUE/FALSE, FALSE otherwise.


IsNonText: 

	Description
	Checks if a value is not text.

	Remark
	Non Text values include dates, numbers, images and blank cells.

	Example
	Ex. IsNonText([A1]) – returns TRUE if the cell [A1] contains non text, FALSE otherwise.


IsNoDataQualified: 


	Description
	Returns True if no data qualified for the report execution. Otherwise it returns false.

	Example
	Suppose report is run to retrieve basic information on 10 employees

Ex. IsNoDataQualified() returns false.


IsNull: 

	Description
	Checks whether a value is null (Nothing in VB).


IsNumber: 

	Description
	Checks if a value is a number.

	Remark
	Does not convert text to numbers. Ex IsNumber(“19”) returns FALSE.

	Example
	Ex. IsNumber([A1]) – returns TRUE if the cell [A1] contains a number, FALSE otherwise.


IsOdd: 

	Description
	Checks if a value is odd.

	Example
	Ex. IsOdd([A1]) – returns TRUE if the cell [A1] contains an odd number, FALSE otherwise.


IsText: 

	Description
	Checks if a value is text.

	Example
	Ex. IsText([A1]) – returns TRUE if the cell [A1] contains text, FALSE otherwise.


Null: 

	Description
	Returns a null value (Nothing in VB).


Type: 

	Description
	Returns the type of value.

	Remark
	Returns 1 if the value is a number, 2 if it is text.

	Example
	Ex. Type(“John Smit”) – returns 2.


 

 

Arithmetic & Geometric Functions

+, -, *, /: 

	Description
	Basic mathematical functions.


Abs: 

	Description
	Returns the absolute value of a number.

	Remark
	

	Example
	Ex. Abs(-23.1) – returns 23.1.


Acos: 

	Description
	Returns the arccosine, or inverse cosine, of a number. 

	Remark
	The input must be from -1 to 1.

The returned angle is given in radians in the range 0 (zero) to pi. If you want to convert the result from radians to degrees, then multiply it by 180/PI() or use the DEGREES function.

	Example
	Ex. Acos(-.231) – returns 1.80390168255052.


Acosh: 

	Description
	Returns the inverse hyperbolic cosine of the given number.

	Remark
	The input must be a real number greater than or equal to 1.

	Example
	Ex. Acosh(10) – returns 2.993223.


Asin: 

	Description
	Returns the arcsine of the given number in radians, in the range -Pi/2 to Pi/2.

	Remark
	The input is the sine of the angle you want and must be in the range from -1 to 1.

	Example
	Ex. Asin(-0.5) – returns 0.5236.


Asinh: 

	Description
	Returns the inverse hyperbolic sine of a number. 

	Remark
	The input can be any real number.

NOTE. asinh(sinh(n)) returns n. 

	Example
	Ex. Asinh(-2.5) – returns -1.64723.


Atan: 

	Description
	Returns the arctangent, inverse tangent of a number. 

	Remark
	The input can be any real number.

Atan returns an angle given in radians in the range -Pi/2 to Pi/2.

	Example
	Ex. Atan(1) – returns 0.785398 (pi/4).


Atan2: 

	Description
	Returns the angle from the x-axis to a line containing the origin (0, 0) and a point with coordinates (x,y).

	Remark
	The input requires two values, the x and y coordinates. 

NOTE. If both x,y are 0 then Atan2 will return the error #Div/0!
A negative result represents a clockwise angle. 

	Example
	Ex. Atan2(1, 1) – returns 0.785398 (pi/4).


Atanh: 

	Description
	Returns the inverse hyperbolic tangent of a number.

	Remark
	The input must be from -1 to 1.

NOTE. Atanh(tanh(n)) returns n.

	Example
	Ex. Atanh(.76159416) – returns 1 (approximately).


Ceiling: 

	Description
	Returns the number rounded up, away from zero, to the nearest multiple of significance.

	Remark
	The input requires two values, the number to be rounded and the multiple of significance.

Regardless of the sign of number, a value is rounded up when adjusted away from zero.

NOTE. If the argument is non-numeric, then Ceiling returns the error #VALUE!

	Example
	Ex. Ceiling(4.42,.05) – returns 4.45.


Cos: 

	Description
	Returns the cosine, of an angle in radians.

	Remark
	The returned angle is given in radians in the range 0 (zero) to pi. If you want to convert the result from radians to degrees, then multiply it by 180/PI() or use the DEGREES function.

	Example
	Ex. Cos(1.047) – returns 0.500171.


Cosh: 

	Description
	Returns the hyperbolic cosine of a number.

	Example
	Ex. Cos(4) – returns 27.30823. 


Even: 

	Description
	Returns a number rounded up to the nearest even integer.

	Remark
	Regardless of the sign of number, a value is rounded away from zero.

NOTE. If the number is non-numeric, then EVEN returns the error #VALUE!

	Example
	Ex. Even(1.5) – returns 2. 


Exp: 

	Description
	Returns e raised to the power of the input.

	Remark
	Exp is the inverse of Ln, the natural logarithm.

	Example
	Ex. Exp(1) – returns 2.718282 (the approximate value of e).


Fixed: 

	Description
	Returns the first argument rounded to the number of decimal places specified in the second argument.

	Remark
	Takes three input:

1. The number you want to round.
2. The number of digits to the right of the decimal to include.
3. (Optional) TRUE/FALSE whether to omit commas. The default is FALSE (includes commas as normal).

	Example
	Ex. Fixed(1234.5678, 2) – returns 1,234.56.


Floor: 

	Description
	Rounds the number down, toward zero, to the nearest multiple of significance.

	Remark
	The input requires two values, the number to be rounded, and the multiple of significance.

Regardless of the sign of number, a value is down toward zero.

NOTE. If the argument is non-numeric, then Floor returns the error #VALUE!

	Example
	Ex. Floor(2.6, .5) – returns 2.5.


Int: 

	Description
	Rounds a number down to the nearest integer.

	Remark
	The input must be a real number. 

	Example
	Ex. Int(2.6) – returns 2.


Ln: 

	Description
	Returns the natural logarithm of a number.

	Remark
	LN is the inverse of the EXP function.

	Example
	Ex. Ln(86) – returns 4.454347.


Log: 

	Description
	Returns the logarithm of a number to the base you specify.

	Remark
	The first input is the number and the second is the base (if omitted base 10 used). 

	Example
	Ex. Log(100) – returns 2.


Log10: 

	Description
	Returns the base 10 logarithm of a number.

	Remark
	

	Example
	Ex. Log10(86) – returns 1.934498451.


Mod: 

	Description
	Returns the remainder after first argument is divided by the second argument.

	Remark
	The second argument must not be 0. 

	Example
	Ex. Mod(27,5) – returns 2.


Odd: 

	Description
	Returns a number rounded up to the nearest odd integer.

	Remark
	The input must be a real number. Odd always rounds away from zero. 

	Example
	Ex. Mod(1.5) – returns 3.


Pi: 

	Description
	Returns the number 3.14159265358979, the mathematical constant pi, accurate to 15 digits.

	Remark
	

	Example
	Ex. Pi() – returns 3.14159265358979.


Power: 

	Description
	Returns the result of the first argument raised to the second argument.

	Remark
	The operator ^ may be used instead of this function

	Example
	Ex. Power(5,2) – returns 25.


Product: 

	Description
	Returns the product of the arguments.

	Remark
	The * symbol may be used in place of product

Arguments must be numbers, cell references or text representations of numbers. 

	Example
	Ex. Product(5,2) – returns 10. Also 5 * 2 - returns 10.


Quotient: 

	Description
	Returns the integer portion of a division.

	Remark
	The / symbol may be used in place of product

This function discards the remainder of the division.

	Example
	Ex. Quotient(5,2) – returns 2. Also 5/2 – returns 2.


Rand: 

	Description
	Returns an evenly-distributed random number between 0 and 1 (inclusive).

	Remark
	To generate a random real number between a and b, use: RAND()*(b-a)+a.

	Example
	Ex. Rand() – returns a random number between 0 and 1.


Round: 

	Description
	Returns a rounded number.

	Remark
	Takes one or two input:

The number to round.
2.  The number of decimal places desired.

	Example
	Ex. Round(5.236, 2) – returns 5.24


RunningSum: 

	Description
	Returns a running total of the input field.

	Remark
	Takes one or two input:

The Data Field you want to sum.
2. OPTIONAL: A Data Field or Category. The running sum will reset to 0 whenever there is a new value for this Data Field or Category.

NOTE. RunningSum should not be used with the AutoSum feature.

	Example
	Ex. 

1. RunningSum({Employees.Salary}) – returns running total of all the employee’s salary.

2. RunningSum({Employees.Salary}, {Employees.Region}) – returns a running total of employee’s salary for each region.

3. RunningSum({Employees.Salary}, {Company}) – returns a running total of employee’s salary for each Company.


Sin: 

	Description
	Returns the sine of the given angle.

	Remark
	The returned angle is given in radians in the range 0 (zero) to pi. If you want to convert the result from radians to degrees, then multiply it by 180/PI() or use the DEGREES function.

	Example
	Ex. Sin(1.047) – returns .0865926611287823.


Sinh: 

	Description
	Returns the hyperbolic sine of a number.

	Remark
	

	Example
	Ex. Sinh(4) – returns 27.1899171971278.


Sqrt: 

	Description
	Returns the positive square root of the argument.

	Remark
	If the input is negative Sqrt returns the error #NUM!.

	Example
	Ex. Sqrt(25) – returns 5.


Tan: 

	Description
	Returns the tangent of the given angle.

	Remark
	The returned angle is given in radians in the range 0 (zero) to pi. If you want to convert the result from radians to degrees, then multiply it by 180/PI() or use the DEGREES function.

	Example
	Ex. Tan(.785) – returns .99920.


Tanh: 

	Description
	Returns the hyperbolic tangent of a number.

	Remark
	

	Example
	Ex. Tanh(-2) – returns .96403.


Truncate: 

	Description
	Truncates a number to an integer by removing the fractional part of the number.

	Remark
	INT and TRUNC are different only when using negative numbers: TRUNC (-4.3) returns -4, but INT (-4.3) returns -5 because -5 is the lower number.

	Example
	Ex. Truncate(9.9) – returns 9.


String Functions

Concatenate: 

	Description
	Joins several text strings into one text string.

	Remark
	The "&" operator can be used instead of CONCATENATE to join text items.

	Example
	Ex. Concatenate(“This “, “is “, “one string!” ) – returns This is one string!


Left: 

	Description
	Returns the first character(s) of a text string.

	Remark
	The first argument is the string you want to display. The second argument is number of characters you want.

	Example
	Ex. Left(“example”, 2 ) – returns ex.


Len: 

	Description
	Returns the number of characters in a text string.

	Example
	Ex. Len(“example” ) – returns 7.


Lower: 

	Description
	Converts all uppercase letters in a text string to lowercase.

	Example
	Ex. Lower(“EXAMPLE” ) – returns example.


Mid: 

	Description
	Returns a specific number of characters from a text string starting where you specify. 

	Remark
	Mid takes three input arguments:

1. The text string.
2. The place you want to start.
3. The number of characters you want to display.

	Example
	Ex. Mid(“example” , 2, 3) – returns xam.


NewLine: 

	Description
	Begins a new line of text.


Replace: 

	Description
	Replaces part of a text string.  

	Remark
	Replace takes four input arguments:

1. The text string to partially replaced
2. The place you want to start replacing.
3. The number of characters to replace.
3. The string you want to substitute. 

	Example
	Ex. Replace("example", 2, 3, "*") – returns e*ple.


Right: 

	Description
	Returns the last characters in a text string.

	Remark
	The first argument is the string you want to display. The second argument is number of characters you want.

	Example
	Ex. Right("example", 2) – returns le.


Trim: 

	Description
	Removes all spaces from text except for single spaces between words.

	Example
	Ex. Trim("This     sentence     has   weird    spacing.", 2) – returns This sentence has weird spacing.


Upper: 

	Description
	Converts text to uppercase.

	Example
	Ex. Upper("example") – returns EXAMPLE.


Value: 

	Description
	Converts a text string that represents a number to a number.

	Example
	Ex. Value("$1,000") – returns 1000.


Formatting Functions

Bold: 

	Description
	Applies the bold formatting to the input.

	Remark
	Can be used to bold part but not all of the text in a cell.
An entire cell can be made bold using the bold button in the toolbar or ctrl + B.

	Example
	Ex. =‘The second half of ‘& bold(‘this sentence is bold.’) – returns ‘The second half of this sentence is bold.’ 


Italic: 

	Description
	Applies the italic formatting to the input.

	Remark
	Can be used to italic part but not all of the text in a cell.

An entire cell can be italicized using the italic button in the toolbar or ctrl + I.

	Example
	Ex. = ‘The second half of ‘&italic (‘this sentence is italic.’) – returns ‘The second half of this sentence is bold.’ 


Underline: 

	Description
	Applies the underline formatting to the input.

	Remark
	Can be used to underline part but not all of the text in a cell.

An entire cell can be underlined using the underline button in the toolbar or ctrl + U.

	Example
	Ex. = ‘The second half of ‘&underline (‘this sentence is underlined.’) – returns ‘The second half of this sentence is underlined.’ 


Other Functions
CellValue: 


	Description
	Returns the value of the current cell.

	Remark
	This function is only used in Conditional Formatting.

	Example
	Suppose a cell of a report displays the price of products. 

Ex. CellValue()> 150 returns True if the price of the product is greater than 150.


FilterValue: 

	Description
	Returns the current value of a filter.

	Remark
	Takes three arguments.

1. The index of the filter.
2. The sub-index used for filters that contain multiple values (i.e. between or one of).

3. (Optional) a true/false indicator if the value should be formatted following the users culture settings. This is used for numbers and dates.   

If there are no filters the function will return an Index out of Range message.

Indexes begin with 1.

	Example
	Suppose the filter summary is “Order Detail.UnitPrice > '3.6' and Products.ProductName is one of ('Boston Crab Meat', 'Tofu')”.

Ex. FilterValue(2,2) returns Tofu.


Hyperlink: 


	Description
	Creates a hyperlink to an external website.

	Remark
	Takes two arguments.

1. The URL of the website.

2. (Optional) the text to display in the cell.
If display text is omitted the URL will display.
NOTE. If PDF exports open in a tab within this application, then clicking the hyperlink may direct a user to leave the application.

	Example
	Ex. Hyperlink(‘www.fakeWebSite.com’, ‘click here’) returns a hyperlink that displays the text ‘click here’ . Clicking this text will open http://www.fakeWebSite.com.


LoadImage: 


	Description
	Loads a server side image based on the input path into the cell.

	Remark
	Can be used to load an image dynamically in place of the insert image feature. The path to the image must be in quotation marks. The entire path of the image is not required if your administrator has set a 'LoadImage' Prefix.

	Example
	Ex. LoadImage("c:/StaryNight.JPG") will return [image: image439.png]





StripHtmlTags: 


	Description
	Removes any HTML tags from the input string.

	Remark
	The input must be a string in between quotation marks.

	Example
	Ex. StripHtmlTags("<h1>This is heading 1</h1>") - returns This is heading 1.


Other
User Preferences

If given permission by your administrator the User Preferences button will appear in the top right corner. Click the User Preferences button ([image: image440.png]


) to open the User Preferences menu.
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Startup Reports

In the User Preferences menu set your preferences such as which reports should run at startup and/or what User Reports should be applied.
· To execute a report on startup either drag and drop it to the ‘Report Name’ panel, use the ‘Add’ button or double-click it.
· To disable a user report click the delete button ([image: image442.png]


).
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Context Sensitive Help

Context sensitive help is available at any point in the application. Click the help button ([image: image444.png]


) and documentation will appear in a new tab. The guide will automatically open to the section discussing the feature you are using.
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